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3D Tiling Backgrounds For The Web

How to Make 3D Tiling Backgrounds For The Web

This tutorial will guide you through the process of making 3D tiling backrounds for use with web
pages, your desktop, or anything else for that matter. We will be using Blender and a graphic editing
program such as Adobe Photoshop or GIMP. I will provide detailed explanation to cator to
beginners, however more experienced Blenderists can probably get away with just following the
picture diagrams provided. You may also find the diagrams useful if English is not your native
language, or if you hate reading instructions.
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Part 1: Create The Object You Wish To Tile

Start up Blender and look at your lonely cube. We will use this cube as a starting point for the sake
of demonstration, but feel free to use any shape you like. Press "Tab" to enter Edit Mode. Press the
"E" key on your keyboard and the Extrude menu will appear. Select "Individual Faces". As you
then drag your mouse cursor you will see some numbers move in the bottom left in the window and
text saying "Shrink/Fatten". I recommend setting it to 1.0000 to keep it simple. Hold down the "Ctrl"
key while dragging to do so in set increments.

Next, with the six faces of the cube still selected, press the "S" key to scale those faces. I recommend
scaling to 0.8000.

Extruding Individupifaces by 1.0000 Stallng aefectedfaces tai 5001

Good. Now that we have created our object we will prepare to tile it.

Part 2: Specify Your Tiling Area

"Tab" back into Object Mode and press "NumPad 7" to go to the Top View, or manually click
"View" at the bottom of the window and select "Top".

Press "spacebar" and from the menu that appears select "Add" > "Mesh" > "Plane". The plane
has appeared, but is obstructed by our cube object, so press "S" to scale the plane to 5.0000.

HNew plane ig obacured Flane scaled te 5. 0000

You'll notice that I've colored my plane black. This is only to make it easier for you to see. You need
not bother with this as we will be deleting the face of this plane shortly.
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-Flarme color changed to black

We now have an easily visible boundary representing the area which will be tiled. If at any point we
decide we no longer need or want this we can move it to another layer by pressing "M" and selecting
a layer to move it to.

Part 3: Tile Away!

Now the fun part begins. If you have created 2D tiling backgrounds before, this concept will be very
familiar to you.

While in Object Mode, select your cube object. At this point you have a couple of options. One is to
make duplicates of the cube object. Another is to make linked duplicates of the cube object. I
recommend making linked duplicates because you can later edit the mesh of one object in order to
change the mesh of all the duplicated objects. This can be especially useful if you later plan to
animate your tiling background (careful not to distract from the foreground). It is also useful if you
want to experiment with new designs easily without having to re-place all your objects.

With your cube object still selected, press "Alt+D" to make a linked duplicate. (Non-linked
duplication is done with "Shift+D") Now hold down "Ctrl" to move in set increments and move the
object to one of the corners of our plane. Make sure the center of the object (represented by a pink
dot) is aligned with the very corner of the plane. At this point you may notice it's somewhat difficult
to tell whether the center of the object is exactly on the corner of the plane, and that's why we are
going to press "NumPad 5" or click "View" and select "Orthographic". For all practical purposes
we can spend the rest of the time we are building the tiling pattern in Orthographic View because
this view is essential for tiling.

Now with your duplicate object still selected, scale it ("S" key) so that is somewhat smaller than the
first. Then rotate it using the "R" key. While rotating you can constrain to a particular axis by typing
"X","Y", or "Z" respectively.

We will now make linked duplicates (Alt+D) of our rotated and scaled cube object and place one in
each corner exactly on the grid (remember to hold "Ctrl" while dragging). If you place an object in
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one corner, you must place it in all four corners because corners touch both the X axis and the Y
axis.

Scale & rotete a= you |l ke Duplicate linked

Now as you will notice in the following diagram, [ made an object that is crossing over the edge of
our plane. This is good. This is how to make natural tiling backgrounds. However! Whenever we do
this we must be absolutely certain to do the same on the opposite side, or else our backgrounds will
not tile properly.

If it exceeds the \ -
plane’s belundaries, .

So now we've created a few objects of different sizes and orientations, however they have all been
along the same spot on the Z axis. So let's give our pattern some depth - after all, that is the joy of
working in 3D!

Before we do this, we'll want to get our guide plane out of the way. So right click on the plane to
select it, then "Tab" into Edit Mode. Press "X" and from the Erase menu choose "Only Faces".
Now "Tab" back into Object Mode. There! We now have only the segments of the plane as our
guide.

Hold down the middle mouse button while dragging the mouse to see what our design looks like
in three dimensions. Now right click one of the cube objects, duplicate a linked copy (Alt+D), and
press "Z" to constrain movement to the Z axis.
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Navigate in this way along the X and Y axis as well and once you've found a good spot, scale and
rotate. Remember to make a duplicate on the opposite side whenever you cross the outline of the
plane guide. You can go on like this and populate your tiling pattern with as many objects as you
wish. The grid is your friend during this process, so you should always have your finger on "Ctrl"
while moving the duplicate of an object that crosses a border of the guide plane. Also, any object
that will "tile" across the border must be at the same point on the Z axis as its counterpart on the
other side of the seam. Press "NumPad 7" periodically to see where you are from a 2D standpoint.
This is the view from which we will eventually render the image, so this perspective is the one that
counts. Beginners, remember that mouse wheel zooms in and out, and "Shift+middle mouse
button" allows you to "drag" your way around.

§

Winen rotaled we seg the depth

Keep in mind that in Orthographic View we do not perceive the depth of objects. Those far away
and those near by appear to be at the same distance. This is what allows us to make a tiled image,
but it also limits the apparent depth of the scene. We can compensate for this by scaling down the
objects we want to appear further away. Or, as in this example, we can just make each object a
different size and place some in front of others.

Part 4: Camera Settings

We will now position the camera directly over our cluster of objects. Press "NumPad 7", center the
view on the cluster using "Shift+middle mouse button", and zoom out a couple notches with the
mouse wheel. From the 3D View Window's menu, click "View" > "Align View" > "Align Active
Camera to View". Now you may be wondering why everything appears to be distorted. This is
because when we changed to the camera's perspective, the view automatically reverted to
Perspective View because by default the camera is set to that view. But just as we changed to
Orthographic View in the 3D View Window, we can change the view of the camera as well. While in
Object Mode, swivel the view until you see the camera. It is represented by a pyramidal wireframe
with a black triangle atop the opening. Right click to select it. Now press "F9" or click the Editing
button (it's icon is four vertices joined in a square). Now in the Camera panel you will see a button
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labelled "Orthographic". Press it. Above the button is a value labelled Scale. Set it to around 20.
(See figure below)
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Part 5: Lighting & Materials

Place some lights in your scene, and add some materials to your objects. Lighting and materials
are subjects which demand their own tutorials, so if you don't know how to do these things yet,
please consult the Wiki.

Note: I advise lighting your scene pretty evenly in order to make the tiling seem contiguous.

Part 6: Rendering

Now that you've presumably got your lighting and materials as you want them, it's time to render the
scene. Under User Preferences click "Render" > "Render Settings" or just press "F10". In the
Format tab you can choose the dimensions of your rendered image, the file format you prefer, and
the quality. I'm going with 800x600 at 100% quality.

Part 7: 'Shopping

And it's time to begin post-production. Open your rendered image in your preferred image editor. I
will be using Photoshop in this example. Now find and mark the four corners of your tile (on a new
layer of course). Just eyeball it.

Mark the tiling points an your renderad image

We will use guides to mark the tile boundaries. In Photoshop guides can be inserted by selecting
"View" > "New Guide...". Guides can be positioned with the Move Tool. You can zoom in and
make sure your guides are accurately positioned by holding "Ctrl" while typing "+" or "-". You can
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now hide or delete the layer with the markers, as that was only to help us get accurate guides.

Should you decide to make an animated tiling background I recommend layering all your frames on
top of one another in your image editor before editing in order to keep the position uniform. You can
then animate them using Adobe ImageReady (comes with Photoshop) or find decent low-budget and
occasionally free GIF animation programs online.

Using guides

Now select an area just outside of the guides with the Marquee Tool. Make sure "Feather" is set
to Opx and that the marquee is rectangular and Style is set to Normal (meaning no Fixed Aspect
Ratio or Fixed Size). Also, it will help you to have Snap enabled, so go to "View" and make sure it is
enabled for guides.

Once you have selected the area, copy (Ctrl+C) and paste (Ctrl+V). Then drag to the right using
the Move Tool and that piece should snap to the inside of the rightmost vertical guide.

Select the Eraser Tool and choose a brush size. I'm going with a diameter of 65. You'll want to use a
soft gradient-like brush for this. Now erase the left edge of the newly pasted selection so that it
blends into the picture. Don't erase any of the right edge.

Press "Ctrl+E" or alternatively, select "Layer" > "Merge Down".

Alright, so that procedure you just performed copying from left to right - now do it bottom to top.
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Once again, erase the edge. Do a Save As.
Finally, select the square center area that will become your tile and do "Image" > "Crop".

Now scale your new tiling background to a web-friendly size. Save As a JPEG, GIE or PNG. You're
done!

Note:If your pattern still isn't tiling quite perfectly, load the version with the guides again and repeat
the copy-paste-erase process. Remember to merge down your layers each time or the corners may
not tile correctly. If still no joy, try tiling the background in a web browser, taking a screenshot,
pasting that into your graphics editor, and touching up from there.
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I hope this has been informative.

Cheers,

--Quantum Anomaly 11:09, 17 March 2007 (UTC) http://www.quantumanomaly.com
All Blender Tutorial Links Back to Blender 3D

Here you can find useful Blender Tutorial Links written in English. Feel free to add some cool
tutorials, but, on this page, only in English. For tutorials in other languages please read About. A
tutorial about editing these pages can be found here. i made my first starting menu New to the 3D
world? Read To Those Learning 3D (http://glenmoyes.com/articles/to _those learning 3d.shtml) .

Official Blender Documentation

Almost all Manuals can be found in the latest official Blender Manual Books. For additional
tutorials look below this topic.

= Blender MediaWiki (http://mediawiki.blender.org/index.php/Main Page) * exposed
= Documentation at Blender3D.org (http://www.blender3d.org/cms/Documentation.628.0.html)

Interface
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= User Interface
(http://www.blender3d.org/ media/education/quickstart/Blender User Interface.html)
Blender Interface Theme Repository (http://www.frontiernet.net/~krich/themes/)
Basic Editing (http://www.ee.oulu.fi/~kapu/cg course/bigfiles/blender/blendman.html)
Blender Hotkeys
Blender Hotkeys II (http://blender.excellentwhale.com/)
Navigating in 3D Space
(http://www.blender3d.org/ media/education/quickstart/Navigating 3D Space.html)
= Product Presentation
(http://www.blender3d.org/Education/index old.php?sub=TutorialPresentation) (Broken Link)
= A short overview of functionality
(http://www.blender3d.org/ media/education/quickstart/Blender Windows.html) (Broken Link)
= Basic Blender (http://www.planetannihilation.com/terragen/tut basic.shtml)
= Rotation, Scaling and Layers Tutorial
(http://www.blenderwars.com/tut-path.php?module=rotation)
= Appending Textures (http://www.b5-blender.com/tutorial4.html)
» Basic Blender (http://www.b5-blender.com/tutoriall.html) (broken link)
Basic Interface
(http://www.users.bigpond.net.au/blendage/pages/beginners_tutorials/tutl/basic interface.htm
Blender Multimedia (http://www.malefico3d.com.ar/tutor/audiovideo-en.html)
Changing Views (http://blender3dfr.free.fr/anglais/tut2/tut2.htm)
First Impression (http://blender3dfr.free.fr/anglais/premiere.htm)
Getting Started (http://blender3dfr.free.fr/anglais/tutl/tutl.htm)
Removing Orphan Vertices
(http://membres.lycos.fr/bobois/Tuts/reperer sommets orphelins/sommets orphilins.html)
» Seeing Textures with Alt-Z
(http://membres.lycos.fr/bobois/Tuts/subdiviser pour conquerir la texture/subdiviser pour cac
» The Camera (http://www.malefico3d.com.ar/tutor/camera.html) (broken link)
= Stereoscopic camera for editing
(http://brunetton.tuxfamily.org/index.php?n=En.BlenderStereo)

Mesh Modeling

» DupliVerts Tutorial (http://dev.newmediaworx.com/johnnyb/bplanet/tut dupliverts.htm)

= How to solve Blender's smoothing problems
(http://feeblemind.tuxfamily.org/dotclear/index.php/2007/08/13/88-how-to-solve-blenders-smo
: discussion about smoothing strategies: Smooth/Solid, Auto Smooth, EdgeSplit modifier...

= Heightmaps (http://members.tripod.com/~funky munky/tuts/blender/heightmaps.htm)

s Mesh Editing Techniques (http://vrotvrot.com/xoom/tutorials/Corridor/Corridor.html)

= Object Extrusion and Procedural Objects
(http://vrotvrot.com/xoom/tutorials/mineRide/mineride.html)

» Loops Corkscrews Problem

(http://membres.lycos.fr/bobois/Tuts/Courbes/tire bouchon/tire-bouchon.html)

Loopings Problem (http://membres.lycos.fr/bobois/Tuts/Courbes/Looping/looping.html)

Knots in Curves Problem (http://membres.lycos.fr/bobois/Tuts/Courbes/Aplat/a plat.html)

ZeTool (http://membres.lycos.fr/bobois/Tuts/Courbes/ZeTool/zetool.html)

DupliFrames Modeling I

(http://membres.lycos.fr/bobois/Tuts/DupliFrames/Modeling/modeling with duplifames en 1.h

= DupliFrames Modeling II
(http://membres.lycos.fr/bobois/Tuts/DupliFrames/Modeling/pizza boxes/stack of boxes en.hi

» Dupliframes (http://membres.lycos.fr/bobois/Tuts/DupliFrames/les_bases/les bases en 1.html)
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= Spin and Spin Dup
(http://membres.lycos.fr/bobois/Tuts/Spin_et spin dup/Spin and spin dup tutorial.html) -
Needs a lot more explanation
= Automatized BevOb
(http://membres.lycos.fr/bobois/Tuts/Extrusion par bev ob/Extl Ext2/Extl Ext2 en.html)
= Extrusion along a Path using BevOb
(http://membres.lycos.fr/bobois/Tuts/Extrusion par bev ob/Alignement des axes/Alignement ¢
= Path Extrusion
(http://membres.lycos.fr/bobois/Tuts/Extrusion par bev ob/Les bases/Les bases en.html)
= DupliVerts (http://membres.lycos.fr/bobois/Tuts/DupliVerts/Dupliverts/dupliverts en.html)
= Limit DupliVerts
(http://membres.lycos.fr/bobois/Tuts/DupliVerts/limiter les dupliverts en.html)
= Types of Handles for Bezier Curves
(http://membres.lycos.fr/bobois/Tuts/Courbes/Courbes de bezier/Types de poignees bezier/T
» Beveled Cube (http://w1.185.telia.com/~u18510119/tutorials/makeacube.pdf) (pdf tutorial)
» Joining/Separating Parts of a Mesh
(http://membres.lycos.fr/bobois/Tuts/joindre et separer/joindre et separer ang.html)
= Extrusion Controlled by IPO
(http://jmsoler.free.fr/didacticiel/blender/tutor/en modelextipo00.htm)
» Basic objects (http://blender3dfr.free.fr/anglais/tut3/tut3.htm)
= Modelling Techniques and Strategies (http://www.elysiun.com/forum/viewtopic.php?t=21382)
» Easily Remove Orphan Edges and Vertices
(http://jmsoler.free.fr/didacticiel/blender/tutor/modesel somparaz en.htm)
= Non-destructive bevel effect
(http://blendertips.blogspot.com/2006/03/bevel-modifier-workaround.html)
= "Cage" Technique Tutorial (http://www.cyphertxt.com/blendertechniquetut.php)
» Creating Fire (http://www.raivestudios.com/tutorials/blender/fire/)

Nurbs and Subsurface Modeling

» [POs, Lattices, Nurbs & Stuff (http://dev.newmediaworx.com/johnnyb/bplanet/tut bottle.htm)

» Cross-Sections (http://vrotvrot.com/xoom/tutorials/Cave/Cave.html)

= Curve Resolution
(http://membres.lycos.fr/bobois/Tuts/Extrusion par bev ob/DefResolU/DefResolU en.html)

= Weight Parameter
(http://membres.lycos.fr/bobois/Tuts/Courbes/Courbes nurbs/Poids des voisins/Poids des vo

s OrderU, UniformU and EndpointU
(http://membres.lycos.fr/bobois/Tuts/Courbes/Courbes nurbs/Influence de order/Influence de

» Curves -n- Bevels (http://www.ingiebee.com/Blendermania/curves%20and%?20Bevels.htm)

s Subsurf Modeling (http://www.malefico3d.com.ar/tutor/subsurf-e.html)

= Making a Hole in Subsurf
(http://membres.lycos.fr/bobois/Tuts/subsurfs/Trouer une surface/trouer une subsurf ang.ht

= Subsurf Edge Rolling - Round
(http://membres.lycos.fr/bobois/Tuts/subsurfs/rouler un bord/rouler un bord rond ang.html)

s Subsurf Edge Rolling - Square
(http://membres.lycos.fr/bobois/Tuts/subsurfs/rouler un bord/rouler un bord carre ang.html

= Modeling with lattices - a fork (http://www.blender3d.org/documentation/htmll/x10279.html)

s Subsurf modeling 2 (http://blender3dfr.free.fr/anglais/tut5/tut5.htm)

m Metaballs (http://blender3dfr.free.fr/anglais/tut6/tut6.htm)

» Abstract SubSurf modeling I (http://www.deviantart.com/view/26691152/)
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Specific Object Modeling

Double-Helix (http://www.deviantart.com/view/27132715/)

Turtle (http://www.elysiun.com/forum/viewtopic.php?t=44686)

Leaf Shader Tutorial (http://www.elysiun.com/forum/viewtopic.php?t=39810)

Sears-Roebuck Dairy Barn (http://www.harkyman.com/searsbarn01.html)

Golf Ball
(http://www.elysiun.com/forum/viewtopic.php?t=31781&postdays=0&postorder=asc&start=:
Celtic Knot (http://jmsoler.free.fr/didacticiel/blender/tutor/cpl celticknot en.htm)

Simple Tree (http://www.elysiun.com/forum/viewtopic.php?t=32306)

Making a pedestal (http://web.telia.com/~u91121962/tutl _1.htm)

Building a Castle (http://www.blender3d.org/ media/education/quickstart/Building Castle.html)
(broken)

Ice Cube (http://caron.yann.free.fr/blender/IceCube.pdf) (pdf tutorial)

Water I (http://www.selleri.org/Blender/tuts/Water.pdf) (pdf tutorial)

Water II (http://www.selleri.org/Blender/tuts/Water2.pdf) (pdf tutorial)

Space Pod (http://dev.newmediaworx.com/johnnyb/bplanet/tut pod.htm)

Grass (http://lib.hel.fi/~basse/) (link moved)

Bongo Creature (http://www.enricovalenza.com/makebongo.html)

Spiral Stairs (http://www.blenderwars.com/tut.php?module=stairs)

Waste Basket (http://www.blenderwars.com/tut.php?module=waste)

Beveled Cube (http://www.blenderwars.com/tut.php?module=bevcube)

Simple Box (http://www.blenderwars.com/tut-path.php?module=box1)

Fountain with Moving Water
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut5/fountain.html)

Track Creation (http://www.geocities.com/swdoughty/blendertutel.html) (dead link)

Dolphin (http://vrotvrot.com/xoom/tutorials/Dolphin/UnderWater.html)

Dice (http://vrotvrot.com/xoom/tutorials/Die/dice.html)

Logo (http://vrotvrot.com/xoom/tutorials/logoTut/logoTut.html)

Cutting through steel (http://vrotvrot.com/xoom/tutorials/Welder/Welder.html)

Roller Coaster (http://membres.lycos.fr/bobois/Tuts/Courbes/completeRC/foreword en.html)
Roller Coster Cobra (http://membres.lycos.fr/bobois/Tuts/Courbes/Cobra/cobra.html)
Modelling a Glass

(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/tp1-index-¢
Ocean View (http://www.ingiebee.com/Blendermania/create%200cean%?20view.htm)

Solar Systems for beginners (http://www.ingiebee.com/Blendermania/Solar%20System.htm)
Chair (http://membres.lycos.fr/bobois/objets a partager/a simple chair.html)

Spiral Stair (http://w1.185.telia.com/~u18510119/tutorials/spiralstair.pdf) (pdf tutorial)
Lighthouse (http://www.users.bigpond.net.au/blendage/pages/tutorials/tutl/lighthouse.html)
Landscape
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/didacticiel-ang.html)
Landscapes Easy
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut2/landscape.html)

Cloth Tutorial (http://www.free-webspace.biz/sonix/BlenderTutes/QuickClothTute.html)

Cup (http://kahuna.clayton.edu/~jbrooks/blender/tutorials/cup/)

Cola cane (http://free.hostdepartment.com/B/Blender3D/cantut/)

Candle

(http://download.blender.org/documentation/oldsite/oldsite.blender3d.org/93 Blender%?20tuto:
= Volcano (http://kahuna.clayton.edu/~jbrooks/blender/tutorials/volcano/)

= Orbital Logo (http://kahuna.clayton.edu/~jbrooks/blender/tutorials/universal/)

» Realistic Planet (http://www.enricovalenza.com/realplan.html)
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= Landscape Cartoon (http://www.selleri.org/Blender/tuts/CartoonishLandscape.pdf) (pdf
tutorial)

» Text (http://blender3dfr.free.fr/anglais/tut4/tut4.htm)

= Text Part 1: Manipulate Text (http://www.raivestudios.com/tutorials/blender/text/)

Human

= Head Modeling
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/head-subsurf/index-ang.htmn

= Head Modeling & Texturing Tutorial
(http://kotinetti.suomi.net/fsware/hippie/tutoriall/index.php)

» Head (http://www.visiontovision.com/BlenderHead 1.html) (link broken)(Part 1 of 12-part Flash
Tutorial)

= Hand Palm (http://jlp.nerim.net/tutorials/hands-modelling/hands-tuto-01.html)

= Make Human: Modeling a New Target
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/04/11/23-didacticiel-modelisation-dur

» Eyes (http://web.pdx.edu/~wlf/tut.html)

» Hair Tutorial (http://www.elysiun.com/forum/viewtopic.php?t=16008)

= Real Hair with Blender 3D (http://www.prodigyweb.net.mx/nivel9/hair/realHair.html) (dead link)

» Female Character (http://otothegardener.free.fr/tutorials/Femme/femme.htm) (dead link)

» Texturing Skin using Vertex Painting and Repeating Image Textures
(http://pages.zoom.co.uk/nick.towers/tutorials/skin tutorial/skin tutorial.html)

» Wikipedia: Human Body Proportions (http://en.wikipedia.org/wiki/Body proportions)

Cars

» Porsche 550 (http://perso.wanadoo.fr/speedtiti/tutoriels.htm) * exposed

= Car IV small (http://otothegardener.free.fr/tutorials/Voiture/voiture.htm) (dead link)
m Car V F1 (http://otothegardener.free.fr/tutorials/F1/f1.htm) (dead link)

» Creating a Toon Car (http://www.raivestudios.com/tutorials/blender/tooncar/)

Texture Mapping

= Making a Lightsaber with Halos (link repaired!)
(http://blenderartists.org/forum/showthread.php?t=62611)

= The Unofficial Texturing Tutorial (http://www.elysiun.com/forum/viewtopic.php?t=11889)

= Material Indice Tutorial
(http://feeblemind.tuxfamily.org/dotclear/index.php/2004/12/21/5-blender-indices-materiau---m

= Raytraced Transparency and Refraction
(http://feeblemind.tuxfamily.org/dotclear/index.php/2004/12/26/7-didacticiel-la-refraction---tutc

= Chrome and Shiny Metal Surfaces (http://www.ualberta.ca/%7Enwy/blender/blender tutl.htm)

= Texturing a castle
(http://www.blender3d.org/ media/education/quickstart/Texturing Castle.html) (Broken link)

» Texturing Tutorial (http://www.planetannihilation.com/terragen/tut buildpics.shtml) (NOTE: For
the game Total Annihilation, not really a general tut)

» Textures in OrCo mode (http://www.enricovalenza.com/textures.html)

» Textures for Allosaurus (http://www.enricovalenza.com/textall.html) (Broken link)

= Texturing Part I (http://www.geocities.com/woodsmith102000/Tutorials1.html?) [Broken Link]

s Texturing Part IT (http://www.geocities.com/woodsmith102000/Tutorial2.html?) [Broken Link]

» Texturing a Ship (http://www.blenderwars.com/tut.php?module=texture)

= Material Indices
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(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/tp2-index-¢

= Textures Channels
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/didac4-ang

» Textures Mapping
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/didac3-ang

= Specular Color
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/didac2-ang

= The Color
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/didac1-ang

= Materials in Blender
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/blender material/index-ang.]

= Alpha, Bump, and Specular image textures
(http://www.ingiebee.com/Blendermania/BumpSpecAlphaTex.htm)

= Image Textures
(http://www.ingiebee.com/Blendermania/attach%20image%?20file%20to%200bject.htm)

= Decals
(http://www.ingiebee.com/tutorials/Decal%20Mirror%20Modelling/theeth%20decal.htm)

» Chrome (http://www.ingiebee.com/tutorials/Digital-Mark.htm)

Alpha Masks (http://membres.lycos.fr/bobois/Tuts/trouer par texture/trouer par texture.html)

Skies I (http://www.malefico3d.com.ar/tutor/skies.html)

Skies II (http://www.malefico3d.com.ar/tutor/skies2.html)

Basic Texturing 2 (http://viewhow?2.qarbon.com/vf/vkxfjoo/7/basictextures viewlet.html) (Java

tutorial) (Broken Link)

» Textures with Alpha (http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/alpha.html)

= Textures with Bumpmapping
(http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/bump.html)

= Using More Than One Color
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut9/two_colours.html)

= Adding Color To Your Shapes
(http://www.users.bigpond.net.au/blendage/pages/beginners_tutorials/tut3/adding colour.html

= Using Textures and Bumpmapping Them
(http://www.users.bigpond.net.au/blendage/pages/beginners_tutorials/tut4/adding texture.htm

» Texture Mapping Tutorial (http://dev.newmediaworx.com/johnnyb/bplanet/tut mapping.htm)
(pictures ok now 18/03/2006)

= Environment Mapping (http://dev.newmediaworx.com/johnnyb/bplanet/tut envmap.htm)
(pictures ok now 18/03/2006)

= Mapping Caracter (http://otothegardener.free.fr/tutorials/LittleOTO/anonce/anonce.htm)

= Creation and Mapping
(http://membres.lycos.fr/bobois/Tuts/boite de projection/boite de projection005 en.html)

= Displacement Mapping
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/displacement/index-ang.htm

= Game Sprites (http://www.ingiebee.com/Blendermania/Game%?20Sprites.htm)

» Stencilling Textures (http://www.ingiebee.com/Blendermania/Stencilling.htm)

» Using Texture Stencils
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/02/27/16-didacticiel-usage-des-masqt

UV Mapping
= Intermediate and Advanced UV Mapping

(http://www.elysiun.com/forum/viewtopic.php?t=25918) * exposed
= UV Mapping & Texturing (http://biorust.com/index.php?page=tutorial detail&tutid=85)
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= Sub-Surf and UV-Texturing problem
(http://barney.gonzaga.edu/~amoorel/uv_mapping project/)

= UV Texture Skinning (http://otothegardener.free.fr/tutorials/LittleOTO/littleoto 3/littleoto 3.htm)
[Dead Link]

» Character UV Textures (http://otothegardener.free.fr/tutorials/Armure/anonce/anonce.htm)
[Dead Link]

» UV Texturing in Blender (http://www.planetannihilation.com/terragen/tut texturing.shtml)

= Tuhopuu UV editor mapping (http://users.pandora.be/blendix/blender/uv/)

= UV Mapping (http://membres.lycos.fr/bobois/Tuts/uvmapping/uvmapping01.html)

» Complex material for a sword
(http://www.3dtotal.com/team/Tutorials/swords &daggers/swords&daggers 01.asp)

= UV Mapping a road and box (http://www.raivestudios.com/tutorials/blender/uvmapping/)

= Create a Software Box (involves UV Mapping)
(http://www.raivestudios.com/tutorials/blender/softwarebox/)

Animated Textures

= Blender TexMesh Tutorial
(http://www.telusplanet.net/public/kugyelka/blender/tutorials/texmesh/texmesh.htm) * exposed

= animating masks for simulating ice freeze
(http://www.elysiun.com/forum/viewtopic.php?p=455683#455683)

= Animated Procedural Textures (http://www.cogfilms.com/tutorials.html) (pdf tutorial)

2D Texture Painting Techniques

This part isn't about using Blender, but about necessary 2D knowledge for advanced Blender
users.

= Steven Stahlberg's Tutorials (http://www.androidblues.com/howto.html) * exposed

= Dirty Metal Texture (http://div.dyndns.org/EK/tutorial/texture/)

» Gritty Pipelines (http://div.dyndns.org/EK/tutorial/gritty/)

= Digital Painting
(http://www.planetquake.com/polycount/resources/general/tutorials/HitmanDaz Tut01/DigitalF

s NWN Texturing Tutorials (http://www.btinternet.com/~i.nation/tutorials/tutorial 00.htm)

» Fixing Lighting Irregulaties in Self-Tiling Maps
(http://www.3drender.com/light/EqTutorial/tiling.htm)

» Texture Map for the Iris of the Eye (http://www.kandsdesign.com/kim/eyemap-tut.html)

= Airplane Texture Tutorial
(http://www.geocities.com/SiliconValley/Haven/2470/txtrtut/txtrtut.html)

» Game Skinning Tips (http://www.planetquake.com/pandemonium/html/skintips.htm)

= Game Lighting Basics I (http://www.planetquake.com/pandemonium/html/skintut3.htm)

= Game Lighting Basics II (http://www.planetquake.com/pandemonium/html/skintut4.htm)

» Texturing with Gimp (http://otothegardener.free.fr/tutorials/GimpTexture/gimptexture.htm)
(broken link?)

Lighting, Shadows and Rendering

» Light - a detailed tutorial (http://www.itchy-animation.co.uk/tutorials/light01.htm)

» Yafray as an Integrated External Renderer
(http://wiki.yafray.org/bin/view.pl/UserDoc/GauravGuide)

» Basic 3 Point Lighting (http://www.andrew-whitehurst.net/3point.html)

14 de 74 10/09/07 17:20



Blender 3D: Noob to Pro - Miscellaneous Tutorials/Print ve... http://en.wikibooks.org/w/index.php?title=Blender 3D: No...

= Radiosity I (http://blenderman.free.fr/tut/radiosity/uk/)

= Radiosity II
(http://download.blender.org/documentation/html/chapter rendering radiosity.html)

= Ramp Shaders (http://www.blender3d.org/cms/Ramp Shaders.348.0.html)

» Simulating Radiosity (http://jmsoler.free.fr/didacticiel/blender/tutor/lumiere radios en.htm)

= Caustic Sampler Tutorial (http://www.elysiun.com/forum/viewtopic.php?t=30265)

= Shadows Control (http://dev.newmediaworx.com/johnnyb/bplanet/tut shadows.htm)

s Light Types (http://www.stormpages.com/eeshlo/otherBlender.html)

= The 'World' buttons within Blender
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/world/index-ang.html)

= Mastering Shadows
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/shadows/index-ang.html)

= Ambient Occlusion
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/01/16/10-didacticiel-locclusion-ambia

= Area Lights
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/01/02/9-didacticiel-les-aires-lumineus

» Depth of Field (http://www.malefico3d.com.ar/tutor/dof-en.html)

Soft Lights (http://www.selleri.org/Blender/tuts/SoftLight.pdf) (pdf tutorial)

Blender's Mist (http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/mist.html)

Basic Lighting (http://www.katorlegaz.com/index.php?a=article&display=1075723200.php)

Optimizing Renders

(http://www.katorlegaz.com/index.php?a=article&display=1078185600.php)

» Flares (http://www.centralsource.com/blender/flares/)

» Toon Shading (http://free.hostdepartment.com/a/aner/TUTORIAL.html)

= Simple Gold Ring with Caustics (http://www.geocities.com/sound man dave/caustics.htm)

Armatures and IK

» Dancing Flor (http://otothecleaner.free.fr/tutorials/Flor/flor.html) * exposed

= Animation Workshop II (http://www.elysiun.com/forum/viewtopic.php?p=511798) * exposed

» Using Ipo driven shape keys to correct deformations in joints (http://kokcito.tk/rvk/ipo.html) *
exposed

= Animation recode project (http://www.blender.org/cms/How Armatures work.634.0.html)

= Action Constraints tutorial made easy (http://www.elysiun.com/forum/viewtopic.php?t=49603)

= Rigged Character (http://www.elysiun.com/forum/viewtopic.php?t=31839)

» Driven Hand Rig (http://www.elysiun.com/forum/viewtopic.php?t=19347)

= Constrained Mechanics (http://argoslabs.com/%7Emalefico/tutor/mecano-en.html)

= Armatures Tutorial (http://www.anycities.com/turbog/Tutoriall.html)

= Animation using Armatures
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut4/animatin armatures.html)

» Tkas Blender 3D - Introduction
(http://mmaigrot.free.fr/didac-blender/ikas/ikas-eng/ik-intro.php)

» Constrained Mechanics (http://www.malefico3d.com.ar/tutor/mecano-en.html)

» Using Armatures (http://www.elysiun.com/tutorials/animation/)

= Making and Using Armatures

(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut3/armatures.html)

Character Animation tools (http://www.elysiun.com/tutorials/animation/) (broken link ?)

IK Solver Constraint (http://www.elysiun.com/forum/viewtopic.php?t=42310)

Softbody for Rigged Characters (http://www.enricovalenza.com/softb.html)

Rigging limbs that can twist (http://kokcito.tk/tut/rig3.html)

Rigging tricks (http://kokcito.tk/tut/rigl.html)
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» JKA Tutorial (http://kahuna.clayton.edu/~jbrooks/blender/tutorials/IKA/)

Animation

= Simple Animation
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/03/08/17-didacticiel-animations-simp.

= Basic Keyframing

(http://www.users.bigpond.net.au/blendage/pages/beginners_tutorials/tut2/Keyframeanimation

Effects (http://download.blender.org/documentation/html/c1585.html)

Character Animation (http://dev.newmediaworx.com/johnnyb/bplanet/tut charanim.htm)

Run Cycle (http://rodri.aniguild.com/tuto run/run_en.php) (Non Blender specific)

Lip Sync I (http://www.meloware.com/blender/lipsync.htm)

Lip Sync II (http://dev.newmediaworx.com/johnnyb/bplanet/tut charanim2.htm)

Walking Blues (http://argoslabs.com/~malefico/tutor/walking.html)

Non Linear Action Editor - NLA I (http://mmaigrot.free.fr/didac-blender/nla/eng/index.php)

Non Linear Action Editor - NLA II (http://argoslabs.com/~malefico/tutor/nla-en.html)

Wave Effect

(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/animation_effects/didac2-an

= Build Effect
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/animation effects/didacl-an

= Animation effects
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/animation effects/index-ang

» Seascape (http://homepages.nildram.co.uk/~raytrace/tutorials.html) (pdf tutorial)(dead link)

» Flag Creation in Blender (http://homepages.nildram.co.uk/~raytrace/tutorials.html) (pdf
tutorial)(dead link)

= Plane Following a Path (http://www.ingiebee.com/Blendermania/plane%20follow%?20path.htm)

= Object Following a Path (http://www.ingiebee.com/tutorials/Path/theeth%20paths.htm)

= Cyclic Animation
(http://membres.lycos.fr/bobois/Tuts/animation cyclique/animation cyclique 01 ang.html)

= Animating Materials
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut7/colourchanging.html)

» Walking Tutorial (http://www.fortunecity.com/skyscraper/true/947/id13.htm)

» Tracking Cameras to Paths
(http://www.katorlegaz.com/index.php?filename=/articles/blender/Tracking Cameras to Paths.

= Relative Vertex Keys (RVKSs)
(http://www.katorlegaz.com/index.php?filename=/articles/blender/RVKs.php)

= Change Cameras during an Animation
(http://www.elysiun.com/forum/viewtopic.php?t=42840&highlight=change+camera)

» Camera Tracking With Additional Roll Constraint
(http://www.elysiun.com/forum/viewtopic.php?t=46181)

Particles

= Particle Interaction (http://blender3d.com/cms/Particle interaction.349.0.html)

» Static Particles (http://www.elysiun.com/forum/viewtopic.php?t=41356)

» Static Particle Effect
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/animation effects/didac4-an

» Particles Effect
(http://www.linuxgraphic.org/section3d/blender/pages/didacticiels/animation effects/didac3-an

= Making a Fireplace (http://www.geocities.com/blengine/fireplacel.html) (down 06.08.2006)
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= Making a Fountain With Particles
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut5/fountain.html)

» Dust Particles (http://www-users.cs.umn.edu/~mein/blender/tutorials/dust/particle.html)

Flames (http://www.centralsource.com/blender/flames/)

Liquid (http://www.centralsource.com/blender/liquid/)

Explosions (http://www.centralsource.com/blender/explosions/)

Smoke (http://www.centralsource.com/blender/smoke/)

= Making a Rain Effect
(http://feeblemind.tuxfamily.org/dotclear/index.php/2004/12/24/4-blender-faire-pleuvoir---maki

» Particle and field basics (http://www.deviantart.com/view/27104504/)

Fluid Simulation

s Fluid Simulation Basics (http://www.deviantart.com/view/27479896/)
» Fluid Tutorial (http://www.penguinscore.com/fluidsimtut.htm) { Broken Link }

Compositing

= Matching Real Lighting (http://www.andrew-whitehurst.net/fx light.html)

= CGI/Live Action Interaction
(http://st102.startlogic.com/~blenderw/cms/index.php?option=com content&task=view&id==

= Compositing CG and Live Action in Blender (http://www.weirdhat.com/blender/compositing2/)

Game Engine

= Game Engine Developing Team
(http://wiki.blender.org/bin/view.pl/Blenderwiki/GameEngineTeam) broken link

= New fully integrated game engine?
(http://www.blender.org/forum/viewtopic.php?t=6409&sid=868ed3b00fd68157b704e87f0cc1

= Game Blender Documentation
(http://web.archive.org/web/20011207173733/http://www.blender.nl/gameBlenderDoc/book1.]
(Last modified 13.07.2001)

= #GameBlender (http://www.antihc3.dyndns.org/gameblender/game.php) (Broken Link)

s Walkthrough Tutorial
(http://www.blender3d.org/Education/index old.php?sub=TutorialWalkthrough) (Broken Link)

= Overlay Scenes (http://www.fortunecity.com/skyscraper/true/947/id16.htm)

s Walking Tutorial (http://www.fortunecity.com/skyscraper/true/947/id13.htm)

= Make a Menu (http://www.fortunecity.com/skyscraper/true/947/id17.htm)

= Flipper (http://otothegardener.free.fr/tutorials/Flipper/flipper.htm) (Broken Link)

= Armatures in the Game Engine
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tut8/realtimearmatures.html)

= Multilevel Maze (http://www.users.bigpond.net.au/blendage/pages/tutorials/tut6/maze.html)

= Creating Boulders that make the map restart when hit
(http://www.users.bigpond.net.au/blendage/pages/tutorials/tutl 0/adding traps.html)

Python and Plugins

= Python Lessons
(http://www.sutabi.tk/timmeh/index.php?option=com content&task=category&sectionid=4&i
* exposed
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= Make Hair (http://www.dedalo-3d.com/index.php?filename=SXCOL/makehair/abstract.html) *
exposed

= Povanim Export Script (http://jmsoler.free.fr/util/blenderfile/fr/povanim en.htm)

= Al Path Importer (http://jmsoler.free.fr/didacticiel/blender/tutor/cpl import ai en.htm)

= 3D-No Plugins; Put your 3D Blender space on web!
(http://www.thoro.de/portfolio/verschiedenes/3DNPhtml)

= Randomizer Script (http://www.elysiun.com/forum/viewtopic.php?t=37400)

Embedding the 3D web plugin in a web page

(http://www.blender3d.org/Education/index old.php?sub=TutorialEmbedplugin)

Different Useful Scripts (http://www.selleri.org/Blender/scripts/text.html)

AfterGlow, Polyline, Hitchcock ZoomEffect, ... (http://www.hgb-leipzig.de/~daniel/blender/)

Dynamica (http://www.centralsource.com/blender/dynamica/)

BlendSaber (http://www.blenderwars.com/tut.php?module=blendersaber)

Lsystem tree maker (http://marief.soler.free.fr/Monsite/lsystem en.htm)

Python Scripting for Procedural Animation

(http://www.ingiebee.com/Blendermania/Genos%20Spring.htm)

Python Scripting Part I (http://www.blenderbuch.de/tutor/pythonl/pythonl eng.html)

Python Scripting Part II (http://www.blenderbuch.de/tutor/python2/Python2 eng.html)

Python Scripting Part III (http://www.blenderbuch.de/tutor/python3/Python3 Eng.html)

Focalblur - A Matter of Depth (http://www.elysiun.com/tutorials.php?id=2)

Python API Introduction

(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python script00.htm)

= Python API, Making a Square Mesh
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python scriptO1.htm)

= Python API, Iterations
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python script02.htm)

= Python API, Automating Vertex Creation
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python script03.htm)

= Python API, Automating Face Creation
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python script04.htm)

= Python API, Making Potatoid
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/python script05.htm)

= Python Script, To build an Empty for EnvMap
(http://jmsoler.free.fr/didacticiel/blender/tutor/english/eng scriptmirror.htm)

= Python Script, Bezier Curves Import
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl curvesimport en.htm)

= Python Script, Paths import
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl paths import en.htm)

= Python Script, Importing Adobe Illustrator Format
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl import ai en.htm)

= Python Script, Lionhead The Movies .msh import/export
(http://www.dcmodding.com/main/index.php?option=com docman&task=cat view&Itemid=&:

= Python Script, Mesh Explosion
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl meshexplosion en.htm)

= Python Script, Level Of Detail (http://jmsoler.free.fr/didacticiel/blender/tutor/cpl LOD en.htm)

= Python Script, Wire Shadows and extrusions
(http://jmsoler.free.fr/didacticiel/blender/tutor/python wireshadows en.htm)

= Python Script, Changing the active camera instantly
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl changerdecamera en.htm)

» Subsurface Scattering in Blender
(http://www.dedalo-3d.com/index.php?filename=SXCOL/experiments/ss_scattering python.htmr
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» Using the Superficial Scattering Script
(http://feeblemind.tuxfamily.org/dotclear/index.php/2005/04/25/39-mh-tutorial-using-the-supei

= City Block Genarator (http://www.elysiun.com/forum/viewtopic.php?t=16217)

» Blender Camera Calibration with Live Camera
(http://www.elysiun.com/forum/viewtopic.php?t=32715)

» Import-export different formats, Different Generators, etc...
(http://www.redrival.com/scorpius/blender-plugins.htm)

s Horn Extrude (http://www3.sympatico.ca/emilio.aguirre/hornextrude.html)

= Mesh shaker and tutorial (http://saltshaker.sourceforge.net/)

= Batch STL (http://blender.formworks.co.nz/batch stl.html)

» Vertices to a Curve Converter (http://www.elysiun.com/forum/viewtopic.php?t=45576)

» Zutils, Z-Buffer Utilities (http://www.elysiun.com/forum/viewtopic.php?t=35355)

Using other Programs with Blender

» YafRay (http://www.yafray.org)
= Verse (http://blender.org/modules/verse/)
» SPE - Python IDE for Blender (http://pythonide.stani.be)
» Wings 3D Subdivision Modeler (http://www.wings3d.com/)
= Verse Gimp-Blender Plugin (http://users.pandora.be/blendix/verse/old/demo.html)
» Kerkythea Renderer (http://www.softlab.ece.ntua.gr/~jpanta/Graphics/Kerkythea/)
s Equinox 3D (http://www.equinox3d.com)
= Wings3D, a Quick and Accurate UVmapping Tool for Blender
(http://mywebpages.comcast.net/jmandmc/uvmap/uvmap.html)
» Povray export (http://jmsoler.free.fr/util/blenderfile/fr/povanim_en.htm)
» Adobe Illustrator Paths import
(http://jmsoler.free.fr/didacticiel/blender/tutor/cpl import ai en.htm)
» Inkscape SVG import (http://jmsoler.free.fr/didacticiel/blender/tutor/cpl import svg en.htm)
» Using Blender content in PowerPoint 2000
(http://www.blender3d.org/Education/index old.php?sub=TutorialPowerpoint)
» Ter2Blend (http://users.skynet.be/sky33676/ter2blend1.html)
= Batch Processing Images
(http://membres.lycos.fr/bobois/Tuts/traitement par lot/traitement par lot ang.html)
BVH Info (http://www.centralsource.com/blender/bvh/)
Stereogram (http://www.geocities.com/blenderlab/tutoriall.html)
Importing VRML (http://www.blender3d.org/Education/index old.php?sub=TutorialVrml)
Creating Quicktime VRs
(http://www.katorlegaz.com/index.php?filename=/articles/blender/Quicktime VR.php)
= Blender, Python and Mac OS X
(http://www.katorlegaz.com/index.php?filename=/articles/blender/Python and OS X.php)
= Stylistic Rendering (http://www.flippyneck.com/temp/NPR.htm)
» Voodoo Camera Tracker (http://www.digilab.uni-hannover.de/docs/manual.html)
= Lionhead The Movies
(http://www.dcmodding.com/main/index.php?option=com smf&Itemid=79&topic=180.0)

Distributed Computing

= BURP - Big and Ugly Rendering Project (http://burp.boinc.dk/)
= Render Planet (https://renderplanet.com/)

= Global Rendering-Farm (http://renderworld.futureware.at/)

= OS X Distributed Blender Network Rendering with Xgrid
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(http://www.katorlegaz.com/index.php?filename=/articles/blender/Using Blender with Xgrid.pl
(Incorrect link?)
» Bfarm Distributed Rendering via Internet (http://geocities.com/tronovan3d/)

Maybe someday ...

= LightRay (http://www.tacc.utexas.edu/~cburns/lightray/lightray.php)
» Toxic (http://www.toxicengine.org/)

Video Tutorials

= BEST: Blender Underground (http://www.blenderunderground.com)

» Official Blender Video Tutorials (http://blender3d.org/cms/Video Tutorials.396.0.html)

= Greybeard's Blender Video Tutorials (http://www.ibiblio.org/bvidtute/)

= Head Tutorial (http://www.visiontovision.com/BlenderHead 1.html) (Part 1 of 12-part Flash
Tutorial)

» Series of short VTuts that explain basic details
(http://www.blendernation.com/2006/03/01/videotutorials-blender-3d-workshop/)

Blender WikiBooks

= Blender 3D: Blending Into Python * exposed
Blender 3D: HotKeys

Blender 3D: Import and Render a SolidWorks Model
Blender 3D: MemoBook

Blender 3D: Noob to Pro

All Blender WikiBooks Modules

FAQ

m Blender FAQ
(http://www.museum.state.il.us/ismdepts/library/linuxguides/blender/blender faq 0.html)
(Generated on September 24, 2001)

» Blender Tips (http://dev.newmediaworx.com/johnnyb/bplanet/tut blendertips.htm)

Repository
This section is not about tutorials, but you can find here different useful stuff for your Blender.
Blueprints

= http://cgworld.ru/modules.php?name=Blueprints *exposed

= http://blueprints.onnovanbraam.com/

» http://smcars.net/

= http://www.boatdesign.net/boat-plans-archive/index.htm boats

= http://www.mgussin.freeuk.com/00Plans.htm old cars
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= http://www.airwar.ru/other/draw 1w.html War Planes
= http://www.suurland.com/ All sorts of cars

= http://jpracing.racerplanet.com/ Cars, Trucks, Buses
Materials

= Sonix' Material Library(esp. Cars)
(http://www.free-webspace.biz/sonix/Cars/Blender234 CarMaterialLibraryR1.html)

Models

» blendermodels.katorlegaz.com (http://blendermodels.katorlegaz.com/)
Photos

= Human Photo References (http://www.3d.sk)
» Brain scan (http://www.med.harvard.edu/AANLIB/cases/caseNA/pb9.htm)

Textures

» Textures Library (http://textures.z7server.com/)
= Mayang's Free Textures Hi-Res (http://www.mayang.com/textures/index.htm)
» Jeremey Engleman's Public Textures Hi-Res

(http://www.art.net/ ~jeremy/photo/public texture frameset.html)
= Image*After Free Images Hi-Res (http://www.imageafter.com/)
= Free Textures Mid-Res (http://digitalcraftsman.com/textureBin/textureBin.htm)
s Sky Maps (http://www.elysiun.com/forum/viewtopic.php?t=24738)

Miscellaneous

CG artists must see or read:

= How to succeed in Animation (http://genedeitch.awn.com/)

» Bitter History of 3D Business (http://home.nordwest.net/Adger/tips/tip077.html)
= Blender Art Gallery (http://centralsource.com/blenderart/index.php)

= Classical Film and Video Knowledge Base (http://www.rondexter.com/)

= Quick Tips in Design&GFX (http://www.atpm.com/9.07/design.shtml)

Open Movies

= www.blenderprojects.com (http://www.blenderprojects.com/)
= Orange (http://orange.blender.org/cms/The Movie.555.0.html)
= NaNo - Blender Internet Virtual Movie Studio (http://nano.prods.free.fr/)

IRC

irc://irc.freenode.net/blender
irc://irc.freenode.net/blenderchat
irc://irc.freenode.net/blenderclasses
irc://irc.freenode.net/blenderqa
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irc://irc.freenode.net/blendercoders
irc://irc.freenode.net/blenderwiki
irc://irc.freenode.net/gameblenderdev
irc://irc.freenode.net/gameblender
irc://irc.freenode.net/verse

Tests

= Blender Benchmarks (http://www.eofw.org/index.php)

Other Lists

Please read more about on talk page.
Tutorials

= blenderartists.org (http://blenderartists.org/cms/index.php?id=38) * exposed

= A Monolingual List of Tutorials (http://www.zoo-logique.org/3D.Blender/index.php3?zoo=dif)
= A Multilingual List of Tutorials (http://membres.lycos.fr/bobois/Liens Links/big list.html)

= Categorized list of Blender 3D Tutorials (http://nututorials.com/tutorials/Blender3D/)

Miscellaneous

» Blender 3D Links & Resources
(http://www.katorlegaz.com/index.php?filename=links/blender 3D.php)

= Blender Heads around the Globe(Where live other Blenders?)
(http://www.frappr.com/blenderheadsaroundtheglobe)

» Blenderart Magazine
(http://s12.yousendit.com/d.aspx?id=14ZVYHLTFHOAK2V3YTCWU38RQ3) Mirror 1
(http://www.apollux-designs.com/BA-Magazine/blenderart mag-nov-05.pdf.zip) , M2
(http://blendertestbuilds.de/index.php?dir=Blenderart/20051115/) ,M3
(http://www.intellidesign.org/blenderart mag/)

= Blender Classroom Tutorial (http://www.statikonline.com/Blender/)

= Blender Tutorials Search Engine (http://www.Blender3DTutorials.com)

= Blender Basics 2nd ed - excellent classroom course
(http://www.cdschools.org/54223045235521/blank/browse.asp?A=383&BMDRN=2000&BCC

About

This links list is language filtered and extended version of personal collection originally provided by
IamInnocent. So if you looking for tutorials in other languages check this link at www.elYsiun.com
(http://www.elysiun.com/forum/viewtopic.php?t=13380) .

» German Blenders should have alook at
http://de.wikibooks.org/wiki/Blender 3D: Tutorial Linkliste

If you want to add Blender tutorial link in some other language you can add it temporary on talk
page. We will later made such WikiBooks in other languages too.

Thank you all who contributed to this nice and useful links collection! Feel free to add your name or
link if you think you need to be mentioned here.
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-- Popski, Mar 2005 link title (http://www.example.com)
All Blueprints Links

= http://www.shipschematics.net/ Starship Schematics Database

= http://www.suurland.com/blueprints_archive.php

= http://www.the-blueprints.com/

= http:// www.modeling.net/ NOT 3D modeling, but human models of the fashion type

Cool things that aren't that obvious

Introduction

Cool things in blender that aren't that obvious. Useful tips and tricks in Blender.

Attribution

Many of The Following Tips and Tricks have been contributed by members of the CGsociety.org
(http://www.cgsociety.org/) , a Public Society for Digital Artists. The tips have been extracted from a
CGsociety thread (http://forums.cgsociety.org/showthread.php?t=52560&page=1&pp=15) . They
have been roughly edited to improve readability.

Navigation / Camera /Layers

Fly mode

enter camera mode (NumPad 0) and press Shift+F move the mouse slowly
click LMB speed up

Click MMB to slow down

press Alt to move up

press Ctrl to move down

Space to keep the orientation

escape to cancel fly mode
Hiding Meshes or Objects

In edit mode press Alt+b and select the area you want to be displayed with LMB. Rest of mesh will
be hiden, until you press Alt+b.

You can also hide all but the currently selected objects by selecting at least one object and pressing
Divide on the Numpad.

Opposite Views

NumPad 1, 7 and 3 puts you on front, top and left view, but Ctrl+1, Ctrl+7 and Ctrl+3 puts you
on back, down and right view (the opposite views).
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Insert key frames for settings such as light intensity and horizon color
Once you have added a lamp or a world, by placing the cursor over the corresponding icon at the

bar (the bar for switching what type of button you see on the buttons window) and pressing the I (i)
key you can insert key frames for settings such as light intensity and horizon color.

"Truck" the camera in camera mode

1) Select the camera by right-clicking on it

2) Go into cam mode with NumPad 0

3) Press G to move the camera

4) Press the middle mouse button to lock the movement to the direction the camera is facing!

Make individual objects the camera and Change them back

If you select certain objects and press Ctrl+NumPadO(zero) it will make them the camera. I use it
all the time to align spotlights.

Select your camera and hit Ctrl+NumPadO to make it the active camera again

Zoom the Floating Panel

you can zoom the floating panel in 3dview (ie Transform Properties [N]) by having the mouse cursor
over one of the and pressing NumPad (-) or NumPad (+). I always keep some floating windows in

the 3d view while modeling, but some time they are taking too much space and I can hide it, as i need
to see the adresse of the vertex.

Pan or Tilt the view

Ctrl+Alt+Scroll wheel and Ctrl+Shift+Scroll wheel, pans or tilts the view respectively
2.37a++

[user comment: Shift+Scroll wheel pans up/down, Ctrl+Scroll wheel pans left/right,
Ctrl+Alt+Scroll wheel tilts left/right, Shift+Alt+Scroll wheel tilts up/down (Blender 2.42a)]

Move to the next screen

Pressing Ctrl+Left Arrow moves to the next screen selection. Ctrl+Right Arrow moves to the
previous...

Horizontal Scroll for the Script Window

In the text window (where you load and write Python scripts), if you have a line that extends off the
end of the screen, you can middle-click-drag the screen left and right, as there is no left<->right
scroll bar. Been using Blender for years and just learned this the other day!

Make Blender always open in full screen
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On windows, blender usually starts in windowed mode. You can make it open in full screen by :

1. pressing Alt+UP_ARROW _KEY or

2. clicking an icon (kind of like inverted ™) located at extreme right of the User Preferences window.
then press Ctrl+U to save user preferences.

NOTE:to come back to windowed mode press Alt+DOWN_ARROW _KEY

Emulating camera target feature of 3D Max

If you place the cursor in the object target, you choose rotate on pivot and rotate camera you
emulate camera target of Max

Alternatively, add an empty, set the camera to track the empty with Ctrl+T. Fix the axis tracking in
animations window. Now the camera will look at the empty where-ever it moves. So move it to a
target.

Adjusting Slider values in controlled increments

In the material editor, hold down the Ctrl-Key while moving the sliders. This will make it jump +/-
100. Then, when using Shift, you it will do a +/-1, instead of jumping some values over, like in
standard mode (without pressing anything). Of course, you can also just change the value by
pressing the number.

Make All Layers Visible
In a case where you have layers 1, 4 and 5 selected. If you press ~ (tilde), then all layers are visible.

But if you press Shift ~, then only the previous layers that you had selected will be visible. You can
use Shift ~ to activate all, or show what used to be selected

Note for french keyboard (AZERTY) : use % (percent) key instead of ~ (tilde) key

File Browser Functions

Delete, Move, Rename, and Make Directory

When you are inside a file browser for loading or saving something and you want to create a new
directory, just add the name to the path on top of the window and confirm '"Makedir'.

you can also delete(x), move(m), or rename(n) a file. you can do action on multiple files by seling with
right click

Preview images when loading them as a texture
Whenever you are loading images as a texture, you can hold down Ctrl while clicking on the 'load’
or 'open' button and the original preview window will appear. But be careful. The preview does not

like certain file types and may crash. That is the reason why it is hidden .

Trick for Creating Quick File Revisions
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After you have saved a blend file or an image you can then save it in progression that is:
car .blend. or car .JPG

Next time do "Save As" then press the + (plus) key which will advance the blend file by 1 every time
it's pressed. example: car .blend becomes car 1.blend. press again car 2.blend and so on.

The - (minus) key will subtract one. I've gotten into the habit of saving frequently. Yea I know there is
now the undo feature but I like this better because it gives you a history in case you need to back a
few levels of a build. You get a saved version at the level you choose.

Note: Blender automatically detects the number... meaning it does not need to be in any position. For
instance: If you have a file named 001starport.png or .blend or whatever, pressing the + (plus) key
will automatically name it 002starport.png. If you want to name it starportl.png, it will change it to
starport2.png.

Two rules: The filename has to have a number. It can be 0, or 1, or 3.141569.

If the file number is a negative, pressing + (plus) key will increase the "magnitude" of the negative
number. I may have used magnitude wrong, if so, I mean pressing the + (plus) key will make -0.04
drop to -0.05. The - (minus) key will bring you only to 0, and then it will start to eat itself up.

Open Recent

Control O

Object/Vertex Manipulation

Constrain Movement to one Axis or to a plane

when moving objects/vertices or set of objects/vertices ([G] key) if you move in the direction of the
global X axis (Up/Down) and then press the MMB, movement will be constrained to only move in
the X axis, or if you move the vertices in the direction of the Y axis and then press MMB it will be
constrained to move only in the Y axis. The same is true of the Z axis.

You can acheive the same effect by using the X, Y or Z keys while in grab mode. You simply have to
press X key, Y or Z, once to lock to X Y or Z global axis,*

To Constrain the Movement to two axes (a plane): Press Ctrl+X to move in the Z-Y-Plane.
Ctr1+Z=XY, Ctrl+Y=XZ *

Alternatively, Select scaling mode and select the axis not to scale with the selecting button at the
same time as you hit Shift.

= in every case You can hit the X,Y or Z button again to constrain movement to a different set of
axes. Normally this different set of axes is local. However you can change the identity of this set
to global, local, normal, or view by pressing Alt+Space. which cycles through the different
identites.

Note: All of these shortcuts work with scaling and Rotating as well
Shrink/fatten mesh in direction of vertex normals

When you're mesh-editing, Alt+S will shrink/fatten the mesh selection in the direction of the vertex
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normals.

Vertex Parenting

You can parent object to a Mesh, in that case you are parenting to the center of the mesh.. BUT if the
mesh is translated somehow (let's say by an armature'[S] pose) the center remains in the same spot,
and thus the child object doesn't receive any transformation at all.

To solve this, you can parent the child object to a vertex (or a face) within the mesh, and any
transformation that the vertex receives is passed to the child.

There are only 2 options, to parent to any 3 vertex withing the mesh or to parent to just one vertex. If
you parent to 1 vertex then only location information is passed, with 3 vertex all transformations
(rotation, location and size) are passed to the child.

How to do it? Starting out of edit mode select the child(ren), hold Shift and select the parent, enter
edit mode, select one or tree vertex, press Ctrl+P. That's it!

Work around to welding Verts

For Edge loop (Verts) position both loops together as close as possible then hit W then 4 (not on
numkey pad). You can adjust how far the effect of collapse can go in the Edit window (a button on
the right labeled Limit: ***, where * is a number).

As for individual Verts, eg. Two vertices welded to become one, select both Verts, scale until they are
very close then hit W then 4.

you can also do this with the snap combo

select the vertex you want to weld together Ctrl+S, Cur -> Sel Ctrl+S, Sel -> Cur [W], Remove
Doubles

Also, whenever Blender pop up a menu with different options, you can just type in a number to
choose one of the options (use the numbers not on the NumPad)

Make individual objects the camera and Change them back

If you select certain objects and press Ctrl+0(zero)it will make them the camera. I use it all the time
to align spotlights.

Select your camera and hit Ctrl NumPad O to make it the active camera again
Ordering Meshes in Vertex Groups

If you are preparing to skin your meshes and you are ready to create the vertex groups, you should
pay attention to the order in which you create them, because once they are created there is no way to
re-arrange them on the vertex-group list.

That means that if you are a ultra-by-the-book person and you would like the vertex group
alphabetically ordered on the list them you must create them in alphabetical order.

.. Or, if you would like them to be ordered according to their function (shoulders, then arms, then
forearms, then palms, etc. you must create them in that order.

This may all sound like a stupid thing to care about, but If you have a character with 39 vertex
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groups you may quickly find that when one of them needs fixing it is a little difficult since they were
randomly created.

Position and scale along face normal,

-Shift V: Position camera along face normal, Alt S: scale selected vertices along face normal

Using Fake Users

pressing Shift+F4 will turn the window into a "Data Select Window™ where you can assign and
unassign fake users to almost everything by selecting the name and pressing the F key

Creating a fake user allows you to keep useful data blocks (materials, textures, base meshes) at hand
even if they are not linked to an object. You can use it to set a default material that would have the
shader you like best.

Align a selection of vertices on a plane

If you want to perfectly align a selection of vertices on a plane, you just have to follow these little
steps:

1.) Before you are selecting the vertices you want to align, position your 3D cursor in the plane that
you want to align to (you could select the 4 vertices of a big plane and hit Shift+S /
Cursor->Selection for example, but you can position it anywhere)

2.) Now select those vertices you want to align

3.) Choose "3D Cursor" under "Rotation/Scaling Pivot"

4.) Now with the [S]-key start scaling mode, hit the key of the axis you want to move the vertices on
X,Y,Z)

5.) Holding down the Ctrl-Key, you can now move the vertices in one line towards the cursor, until

the value for the chosen axis is 0.000. Alternatively, just enter, using the keyboard, the scale factor
you want (0 in this case) .

6.) Hit LMB. The vertices are perfectly aligned along a plane through the 3D cursor.

This even works very well while in perspective view mode, so you can align on the fly and don't have
to switch to front/side/top view all the time.

Welding Vertices

You can weld vertices by selecting them in edit mode and pressing Alt+M.

View wireframe of hidden Verts

to view the wireframe of hidden Verts, make sure you are in WIREFRAME MODE and then turn
SubSurf on and change the level to 0 If you already knew about this then

Select a true loop
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shortcut is Shift + Alt + right Button of the mouse, serves to select true loop, in vertices as in
edges like in faces.

Selecting one object from a single mesh comprised of multiple objects

If you have more than in Edit Mode, you can place your mouse cursor next to one of the Verts in the
desired object, then press the "L" key to select all of the Verts linked to that one. "Alt+L" reselects in
the same manner.

Precise Zoom and Select/Deselect

Selecting: If you Hold down the Ctrl+LMB (left mouse button) and drag the mouse, it will allow you
draw a selection as opposed to using the B button which gives you a square.

Deselecting:To draw an area to deselect, Hold down the Ctrl+ Shift+ LMB(left mouse button) and
drag the mouse,

Zooming:Hold down the Ctrl+MMB. Move your mouse vertically to can get a more controlled
zoom versus scrolling the Mouse wheel.

This feature may not be present in 2.37 or earlier versions.

Mouse Gestures

Left click and draw:

» a straight line - moves the selected object.
» a circle - rotates the selected object (note: this must be drawn fairly circle-like).
= a 'V - scales the selected object.

Selecting Obscured or Hidden Objects
Say you are in front or side view and you want to select an object, but it is obscured or hidden

behind other objects. If you press Alt RMB over a group of objects, a menu will be displayed in the
3D window allowing you to pick the object you wish to select.

Select or Deselect Multiple Vertices

In Edit mode, when you click the RMB near a vertex that vertex (face or edge)will be selected, RMB
again will reselect. By holding the Shift key this will allow you to add each selected vertex (face or
edge) in that highlighted group.

Pressing the U key (Undo in Edit mode) will also remove the last selection you made.

Alternatively, you can Press B and then draw a box with MMB. Anything caught in the box will be
deselected. Also works with BB and the draw selection. Draw with MMB and you reselect.

Selecting multiple items

You can use right mouse button to select multiple items to append. Doesn't seem to work with files.
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Measuring, length, distance on an object.

Hit "F9" (editing), you should have split (2) windows. One "3d" the other "buttons" go to the Mesh
Tools 1 panel and press the Edge Length, Edge Angles and the dimensions will appear on your
selections in the 3d view.

Adding Connected Vertices

In Edit Mode, if only one vertex is selected, pressing "E" will add a vertex, on a freely defined place,
connected to the selected one. As will holding CTRL and left clicking the mouse where you want the
new vertex to be positioned.

Note: It must be an Image texture and in wireframe mode to be visible.

(2.37a)

Recalculate Normals

Ctrl + N = Recalculate normals outside (you might have to select faces before doing so) Shift +
Ctrl + N = Recalculate normals inside

These two hotkeys are useful when you extrude some edges and see a kind of seam in between (due
to normals pointing in different directions).

Then, after selecting an edge, Ctrl + NumPad (+) selects the face associated with this edge. Ctrl +
NumPad (-) deselect the face.

Create a Quad from two Tris

Alt + J when having two Tris selected makes a Quad.

Remove Doubles

To Remove Doubles use hotKey: W. You can adjust the "limit" option so that "Remove Doubles" has
more or less tolerance. This option is located in editing window under the mesh tools panel, (i.e.

weld vertices that are further?)

Combine edit levels on a mesh.

When in Edit mode for a mesh (TAB key) you can choose the level that you wish to edit at. At the
bottom of the 3D window, there are four buttons. Vertex, edge, face & back-face cull.

By default the vertex level is selected, if you hold Shift and press the edge button, you can use both
at once.

Change Select Mode

to change select mode (vertex, edge or face) you can press Ctrl+Tab. But this way you can't use the
Ctrl+Key to ADD the select modes.. Still could be useful, if you don't have a header for the window
you're working in..
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Working with Meshes

Turning Sub-Surfed Mesh into Normal Mesh

If you have a sub-surfed mesh you can turn THAT sub-surf mesh into a normal mesh. Just select the
sub-surfed mesh and press Alt+C (Conversion).

How to remove (numb) black spots on a Mesh

If a Sub-Surfed mesh becomes (numb) black on some places, that's because of the normals. Select
all and press Ctrl+n and then confirm. now it should look prettier!

if the above solution does not work , save your Blend file, Quit Blender then restart. Use Ctrl O to
open the last file and your mesh will have returned to correct shaded state.

Select all holes in a mesh and fill them

Shift+M* selects all Non-manifold edges/vertices (holes) in a mesh **. Then all you have to do is hit
Ctrl+F to auto-fill those holes with "beauty fill".

Shift+M is an alternative shortcut for 'Select Non-manifold'. You'll find this in the select menu when
in mesh edit mode. The listed short cut there is Ctrl+Alt+Shift+M. Shift M is obviously a lot more
comfortable on the fingers though!

Although 'Non-manifold' usually refers to holes in your mesh, it is not necessarily only holes eg, an
edge with three faces coming out of it is also a non-manifold edge!

Fill in four or fewer vertices

select the vertexes and press [F], this will fill in the empty space around them

to clean up a filled in space, select all the vertexes for the area, and press [F]. choose OK to make
FCon For example: add a plane in wireframe mode, extrude it several times, select all vertexes, then
hit [F].

Animation

Animation Preview in all windows at the same time

It is well known that Alt+ a is for previewing an animation on the 3D window. But that's not all of'it.
Divide your screen into multiple 3D Windows, each from a different point of view.

Press Alt + Shift + a
Enjoy!!!

If you have an Action/Ipo Window and 3D windows open, and you issue the Alt + Shift + a
command from the Action (or the Ipo) window, it will animate both (the action and the 3D) in sync!!
Great for visualization of Ipo's effect on your model.
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Choose animation mode, Convert mouse movements to IPO

-T in IPO window: Choose animation mode, ie., linear, bezier, constant -[R] in IPO window: Record
mouse movements, and convert to IPO

Animate procedural textures

To animate procedural textures, press 'i' with the mouse pointer in the materials window, and select
the type of Key-Frame you wish to set in the pop up menu. advance a few frames, tweak your
materials, and set another key frame.

UV Mapping, Particles and Texturing

Blender color picker

Blender has a PhotoShop-esque color picker. Simply click on the color preview next to the sliders to
use it. Hit enter when you have the color you want.

Saving your face groups selections

Regarding UV mapping and Face Groups Selections there seems to be the general misconception
that you can't save your face groups selections on Blender.

Most people already know that from within the Face Select Mode (Potato Mode) you can switch into
Edit Mode and whatever selection you do while in Edit Mode is passed back to Face Select Mode
when you exit the Edit Mode.

Well, Did you ever wonder why Material Index Groups (that are nothing more than face groups with
a common material on them) have those little 'Select' and "Deselect' buttons there? Sure they come
handy for later modification of the material index but that is not all about them.

Do this: Before starting the UV unwrapping job, cut your mesh by creating as many material indexes
as you need, you can even assign each one a different color so you can be sure that there is no face
orphan. Once you have the mesh all cut and sliced (so to speak) you enter in Face Select Mode, then
switch into Edit Mode, select the index containing the faces you want to unwrap, press 'Select’, leave
Edit Mode and Voile! You now have an entirely useful face group waiting for you to unwrap. No more
manual (and imprecise) face selection is needed.

If you later need to change the mapping of those faces, don't fear. Just make sure there isn't any face
selected on Potato Mode, do as you did first (enter edit mode, select the index, exit edit mode) and
there are your very same faces selected again with the UV mapping you already assigned to them.

Note: Another benefit of have precise face selection groups is that, initially, you don't have to worry
about UV coordinates overlapping, since you know have the way to select ONLY the faces you want
to. For example, you unwrap all your faces by groups and when you are done you can start thinking
about scale and position withing the texture map, not like before when you have to solve those
things as you go.

Bulk Texture Change
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Consider a scenario in which you have a scene with a 100 mesh objects, and 50 of them have one
texture and 50 of them have another.

If you want to change the texture of the first 50, but don't want to change each individually, do the
following. Add a Plane out of the view of the camera. Add your new texture (Material) to the plane.
Then use the “Copy to material Buffer” button in the header of the Material buttons. Select one mesh
object of the same sort that you want to change, open Material buttons and Paste from Material
Buffer.

All the mesh objects with the same texture will now have the new texture.
Alternatively, If you have a material that you want to apply to a lot of objects at once:

1. Select all the objects you want to apply the material to. 2. Apply a material. (this only applies to the
last selected object) 3. press Ctrl+L > Materials. (this links the material of the last selected object to
all the other objects)

Negative Meta-Balls

Add>Metaball as usual. Exit EDIT mode and Add>Metaball. This time before you exit EDIT mode, hit
the Negative button in the EDIT buttons window. Then leave edit mode.

If you move the negative Metaball around, you can see the effect it has on the positive metaball.

Be careful though, as negative metaballs are not displayed in the same manner as positive metaballs,
you will only see the Pivot point not a meta-mesh.

This is a little test you can try to see the amazing effects negative metaballs can produce.

Make 1 Metaball, make it big. Place three spheres (UV) inside, make them emit particles, one 100,
one 200, one 300 particles. Parent three negative metaballs, one to each sphere, and use dupli-vert
on each sphere. Make the 100 duplicate metaball quite big, the 200 medium and the 300 small. Hit
Alt A to run animation in 3D window.

Click here for his negative metaball thread
(http://www.elysiun.com/forum/viewtopic.php?t=14058&highlight=metaball)

Maintain the UV layout when moving/scaling/rotating UV co-ords.

When you have the UV image/editor window open and have loaded an image you want to UV map to
a mesh, click on the UV tab in the header bar and turn off 'Snap UV to pixels'.

This will help to maintain the UV layout when moving/scaling/rotating UV co-ords.

Rendering

Tricks, related to the view ports and the render buffers

First. Switching among screens

So you have your screen made off the 3D window, the buttons window and the info window... but
you are doing some fine tunning to the mesh in two places simultaneously, and they both need to
zoom in the 3D window. You could scroll or zoom out, translate the view and zoom in again. None of
them an elegant solution.
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Another situation. You are working on a model and are using an image for reference. You are not
tracing over the photo, just take a look at it often to make sure you don't deviate to much from the
concept. So you open the photo in a 2D program and keep switching back and forth from Blender..
or you have the photo open in an image window and keep maximizing and minimizing the window...
another hassle

Worry no more!!! Blender can handle multiple virtual screen (ala Linux) and you can come and go
from them with just one key stroke.

Just press Ctrl+Left Arrow or Ctrl+Right Arrow and you are switching screens. Go ahead! By
default EVERY .blend file comes with 3 screens ... and of course you can add/delete as many as you
see fit.

the magic button to add or delete screens is right beside the Tools menu, up there in the info
window.

Using the render buffers

Ok, so you set your scene and press RENDER, a nice window comes up and you see your hard work
coming to existence (that's the default behavior, if your change it on the display buttons then this
may not work for you).

Do you realize that the window containing your render image is also a render buffer? Actually they
are 2 buffers for your to play with. Whenever the render window is open (and you can re-open it by
pressing F11 without having to wait again for the render) if you press the ] key you can switch from
Buffer A and B. (the last active one is what you save when you press F3). You can even switch
buffers in the middle of a rendering (but I advice against that when rendering very complex scenes,
you have been warned!)

The cool thing about having two separate render buffers is that you can have instant
before-and-after images for things that you change in the scene. For example you are searching the
perfect position for a light source in a scene, you place it and do a render, place the light in another
position, switch to the second buffer and do a new render. Now, with the render window open, just
press J to see how the change on the light's position influence your scene and that makes your
decision easier.

By the way, the render window can be zoomed (by the normal ways or by pressing Z ) to do a closer
inspection of the image.

Render window Tricks

To zoom into the render window, use the Z key.

To find out what the (Red, Green, Blue, Alpha) values of rendered image are, left click and hold the
button of your mouse.this will reveal the RGBA values of the pixel below the mouse cursor.ie R 127,
G 255, B 13, A40. The values will appear in the bottom left corner of the render window. You can also
hold the button and drag the mouse around. This will display the values of the pixels your mouse
pointer passes over.

With the render window open, you can press the A key to view an an alpha version of the image.

After rendering, you can use hotkey ] to use a spare render. After the second render, you can use it
again (hotkey ]) to jump back to the first render, and then back to the second, thus making it easier
to compare slight changes.

Working while you Render
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If you use a X/X11 based window manager, you do not need to watch blender while it renders, go to
a different virtual desktop. Blender doesn't have to keep X informed of what's going on and
rendering speed may increase.

Border Rendering

In the rendering buttons find the buttons marked "Border" and "Crop". If you depress "Border", you
can get a rendering of any part of what the camera sees. Just do the following :

Go into a camera view using NumPad 0, press Shift+B. Then, mark the limits of the rendering as
you want them using LMB. Next, render the usual way and the section you marked will be rendered
first, then it will be integrated to the complete rendering. If you wish that *only* the chosen section
would be rendered then click on the button marked "Crop" also.

Creating a cluster of particles which takes little time to render

Render some particles, and make the picture into an alpha mapped tga in GIMP or whatever
graphics editing application you use.

Load the image onto a plane. Adjust the alpha settings accordingly. Parent the plane to the emitter.
Press dupli-verts.

You now have a cluster of particles which takes relatively little time to render. Of course it doesn't
have to be an alpha map of particles. That's entirely up to you.

Alpha from render view
When cut & pasting stuff from render window to {insert your favorite image editor here} using
Alt+ PrtScr, cut and paste the render first, come back to render window and press "A". It changes

the view to alpha and you get black & white mask to cut the background nicely in the {again,
favorite image editor}. Nice when you do testing in low res.

View alpha texture as wire.

Ctrl+d in 3d very usefully for preview without rendering.

Also, if you have an object (works best on a mesh plane) with an image texture, you can use Alt+V
key outside edit mode. This will adjust the object's size values so that the image won't be stretched
when projected.

Miscellaneous

Restoring your “lost” work.
If you go to the temp folder where you have Blender save it's temp .Blend files, reload the most
recent one and this will save you losing the whole of your work. You don't even need to save a .Blend

file for this to work. You can change the settings for this in the tool window at the top of the Blender
screen.

Built in Hot-Key List

Since the few last versions (since 2.28 I think) blender has a built-in all inclusive hot-key list. Just
open a text-editor window, and right besides the option to create a new text-buffer there is a menu
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option called "KEYLISTintrr". Select that option and the full list is loaded in memory

--Edit: There may be many hot-keys missing, especially the newest ones, like M to mirror a mesh, K
for the Knife tool, Alt+Z for textured view... but the list is a good start at least.

Un-compiled PlugIns

Blender can load plug-ins for texturing, sequence editor, etc. . However, Blender comes with a few of
such PlugIns un-compiled.

In Linux they are located on the plug-ins sub-directory of the default Blender install, and all that you
need is a Make command to compile them. I don't know how to compile them in Windows, but there
they are, just waiting for you to awake them!!!

Blender “Easter Eggs” (Weird things included in blender)

All Publisher versions of Blender have been shipping with a Monkey mesh called Suzanne. Just open
the main tool box (Space Bar) -> Add -> Mesh -> and right below the other primitives you'll see
the Monkey.

Why/What it is for? Only NaN programmers know*. It is supposed to be a private joke among the
blender developing team. However, it is incredibly useful as a quick complex object for testing
textures, shaders, etc..

By the Way, Suzanne isn't the only joke included... but I won't spoil the surprise. You will bump with
them on your daily work, that is for sure.

= NaN was the company that originally developed Blender
Weird Error Message

Sometimes, when trying to use a boolean on a tri-based mesh, Blender gives the prompt: "Wanna
Crash?" >Yes Please!

but clicking it doesn't crash. This is because Blender is a lot more stable now compared to when that
‘crash' request was coded. It also used to appear when using beauty fill after face fill. (Ctrl+F in edit
mode)

Blender 2.37 now has a 'widget', which replicates the red/blue/green axis symbol in 3DSMax in the
3d windows. Rotation scaling and movement of objects/Verts/faces etc, can be manipulated using
the widget, or in the usual manner of earlier versions of Blender.

Turn your blender animation into a screen-saver (Windows)

to turn your blender animation Windows binary file into a Windows screen saver, rename the EXE
file into SCR and right click it and install !

Discover the FPS rate of a Window

If you hit Ctrl+Alt+T key in a window, Blender will tell you how much time it takes to render a
single frame of that window, in milliseconds. Valuable Benchmark
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27??

using construction widget press Shift to get precision mode for fine tuning. Release left mouse
button (LMB) and holding Shift down press it again, then you'll get moving along another axis.

Sculpt Mode Hotkeys

F: an interactive brush resize Shift F: an interactive brush strength adjuster Ctrl F: in interactive
texture angle adjuster for your brush. Shift B: a rectanglular zoom selection for close-up work Alt B:
hides all but selected rectangle A: toggles airbrush S: smooth D: draw G: grab L: layer I: inflate P:
pinch Use X, Y and Z to toggle axis mirroring.

Ways to create "fluffy" effect (materials and lights) The ways to create "fluffy" (brightened) edges.

based on this Elysiun thread
(http://www.elysiun.com/forum/viewtopic.php?t=42662&postdays=0&postorder=asc&start=0)

= Spherical Blend texture method

Add a Blend texture set to "sphere" (circular pattern in preview). map it to empty|empty|Z
coordinates and coordinates source to "Nor" instead of "Orco" , set method to Add and channel to
Emit.

» Backlight (aka "@ndy's top secret material" :) )

Just add a sufficiently, but not overly bright, colored Hemi light behind the object (relative to
camera). You may need set it to be "layer only" light if it interferes with rest of a lightring rig. Like
ramp, this method can make edge not just brighter but of different color.

= Color ramp (http://www.blender3d.org/cms/Ramp Shaders.348.0.html) with input set to
normal.

Pretty straighforward, but many advise against it.
» Minnaert shader
Available in 2.37, "Darkness"<1 actually brightens edge. A cool shader, but not very useful for this
purpose.
Compiled by : Trident
Troubleshooting

ATI Radeon Slowdown Problems

Go the the ATI site driver downloads section and select the appropriate OS/graphic card. This will
(most likely) link you to the d/1 for the current Catalyst 4.4 drivers.

At the bottom of that page is a link to "Previous driver versions".
D/L the Catalyst 3.7 driver package. Run the EXE and it will extract the driver install package to:
C:\ATI\SUPPORT\
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In this directory will be a directory named (for XP/Win2K users:
\wxp-w2k-7-93-030812a1-010735c-efg\

This is where the driver install package is located. DO NOT RUN THE SETUP. You don't need to
install the old driver.

Navigate down thru the dir structure to the following dir:
C:\ATN\SUPPORT\wxp-w2k-7-93-030812a1-010735c-efg\2KXP INF\B 10679

In this dir you'll find a file called: atioglxx.dl This is a "packed" version of the ATI OGL driver.

The next step specifies how you can extract these files to your hard disk using the 'expand.exe'
utility included on the cd.

The '1386' folder on the Windows XP CD contains a utility 'expand.exe' that can be used to
uncompress all compressed dll files. It is a commandline utility, so you have will have to run it from
either the command prompt or the Run dialog. Some examples of its usage are:

expand X:\I386\ADROT.DL_ C:\ADROT.DLL
The above command decompresses the compressed DLL

ADROTDL on the WinXP CD, copies it to C:, and changes the extension to .DLL..

Just extract that file (atioglxx.dll) to your Blender install directory. Usually C:\Program Files\Blender
Foundation\Blender\

Launch Blender.... no more slowdown.

Addendum: I found this solved a problem of crashing on start up after updating my Catalyst driver
from 7.2 to 7.8, that is expanding the old 7.2 atioglxx.dl to atioglxx.dll and copying it to the Blender
directory.

For people who the above solution leads to Blender crash at start up

Thanks to Xenobius at Blenderartists Forum

This solution is tested on ATI radeon express 200 (x200) integrated video card. However it should
work on other ATI card.

Download the Nvidia 53.03 Driver HERE
(http://www.megagames.com/news/redir.cgi?http://download.nvidia.com/Windows/53.03/53.03 win:

Extract the driver to C:\NVIDIA

Copy the nvoglnt.dll from the C:\NVIDIA folder to your blender program folder (ie. C:\Programs
Files\Blender 2.40\)

Rename nvoglnt.dll (the one in the blender program folder) to atioglxx.dll

Run blender...Viola! Blender runs like it should!

[this also works by renaming any .dll to "atioglxx.dll". Try it by copying and renaming any of the .dlls
in the blender folder to it, then launching blender. Worked for me!]
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General Advice on Modeling Realistically

Modeling Realistically - Tips and
Techniques

Everyone who starts a new career or hobby in 3D Modeling also seems to look around their
immediate environment for things to model. Things like your computer monitor, your keyboard, and
even the desktop which they are resting are all common "first models." Developing an eye for
geometry takes time and this is a great chance to practice.

For this tips and techniques discussion, I'll start with the concepts of furniture and walls, but the
ideas really extend to anything and everything you can model in Blender, from spaceships to fantasy
demon-women, from your barbecue deck blueprints to biologically accurate squids.

Assemble Things, Don't Chisel Them

Let's start with the furniture around you.

You may think it's easy to model your desk using a couple of boolean operations on cubes. But it
rarely comes out looking quite right. It seems like such a good idea at first. Then you find that the
drawers won't open realistically. The corners are all amazingly sharp and crisp. The writing surface
seems to be at the wrong scale for thickness. The woodgrain goes in the same direction everywhere.
You then realize it will be hard to bevel just the few edges that need beveling. The more you look at it,
even with good render settings, the more it looks like dollhouse furniture instead of a real life, full
size desk.

Real furniture is not chiseled out of a half-ton cube of mahogany, because trees don't grow that
thick, and it's a real waste to chip out the spaces for drawers. Instead, cabinetmakers tend to
assemble a piece of furniture from many component parts. Think of those "self-assembly" kits from
the local superstore, or even the showroom examples from a nearby unfinished knotty pine store.

Model several kinds of boards and fittings, then copy and assemble them appropriately. You don't
need to model every nail and dowel, and you don't even need to know what a dovetail joint is. But
you can make realistic furniture when you build things from their natural components.

= Cut lumber in a variety of sizes and thicknesses.

= Measure real example furniture and take note of the construction details.

= Choose varying woodgrains by duplicating materials and adjusting them to be more individual.
= Align those woodgrains or other materials in an appropriate direction and scale for the model.
= Bevel just the parts or edges which are naturally worn or intentionally beveled.

= Any cloth, glass or metal fittings are separate components using their own materials.

= Create an "Empty" type object, give it a descriptive name, and parent all of the pieces to it.

There are a couple more benefits to this form of component modeling:

= Working with things made from multiple real materials is easier: one object, one material.

= The model is more flexible, because they can be reconfigured to other styles more easily.

= Components come in handy for other models: adapt a desk's drawers in kitchen cabinets and
bedroom furniture.

Separate Objects for each Material
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A common question for new modelers is how to make one
mesh that uses more than one material. For example, a
skateboard with metal trucks, rubber tires, and a wooden
deck. While Blender does provide an interface to allow
such a combination, it is not usually the best approach for
modeling realistically.

If you model the skateboard as separate parts, based on
the way different real parts are assembled, then you have a
lot more control over the final model. You can replace the
wheels or use trucks of different styles later. You can
adjust the mesh that defines the shape of the deck, without
having to re-assign the areas that should be one material
or the other. And lastly, you can choose to use subsurface
tricks on the various parts, while avoiding them on other
parts. Even if the whole model needs subsurfaces, it
becomes a bit hard to control where one material starts, and another material ends.

skateboards, modeled in parts

Removing the Fourth Wall

Just as with furniture, you may model your first building interior as a hollowed-out cube. It seems
straightforward to make a big cube, turn it inside out, and call it a living room. There are a lot of
drawbacks to working with a room that was carved out of a single chunk of solid rock.

Buildings and rooms are assembled from parts. Just like the furniture modeling tip, design your
rooms as a collection of separate pieces.

= You don't need to measure out the internal beams and joists, but remember they're there.
= Each interior or exterior wall should be its own object or assembly.
= Take care to note the correct dimensions and placement of doorways, windows, ceiling.

The benefits of a component-modeled interior include:

= Easier to see inside, just hide some walls on a different layer.

= Walls are much easier to move around to reconfigure the room layout.

» The same modeling work on one area can be copied to other rooms more easily.
= A more realistic architecture with consistent scaling is achieved quickly.

Proportions and Measurements

For realism, it's vitally important to get the right proportions for familiar objects. If your audience
sees a bookshelf with 5" thick shelves, or a human hand which has a 5" long thumb, their brain is
going to tell them that something is wrong. They might not be able to decide why, but they'll tell you
it looks fake.

Even when you're animating fantasy characters, you should develop an understanding for
proportion. Many cartoon characters have very large heads when compared to their bodies; this
allows room for greater expression and makes the characters seem younger. Deciding how many
"heads high" each character should appear will ensure that your figures all maintain proper
proportions to each other and to their environment.
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To get good proportions, you need to think about
measurements.

= Grab aruler or find some existing blueprints.

» Think in terms of those measurements for the
duration of the project.

= Choose a base scale that will let you work
comfortably within a 500x500x500 unit volume.

= Blender limits cameras to 1000 unit distances, for
better numerical accuracy.

You can mix and match base units, by using Empty objects
as parents. For example, you can model your furniture in R .

inches or centimeters, and model your house in feet or soda cans and glass, modeled in parts
meters. Then when you append your bed.blend's objects,

just parent that bed to a new Empty object, and scale the

Empty. This will conveniently scale all of the separate component pieces of the object together.

There's only one big wrinkle with working with multiple scales: materials should be designed with a
certain base scale in mind. Many material surface properties are scaled according to the units you
choose for a given object, or the world units. Just consider this as you design, and check your work
critically.

Halley 20:18, 21 January 2007 (UTC)

Using Blender Libraries You can append libraries in two ways. You can make a local copy of data
blocks (like objects, meshes, ...) of the content of a .blend file in your .blend file (appending) or you
can use data blocks from another .blend file (dynamic linking).

You can Append with the command in the 3d view File -> Append or SHIFT+F1. When you give
this command a file browser window opens. There are two buttons Append and Link at the bottom
of the window. The default action is appending. But you can use dynamic linking selecting the link
button.

At this point select the .blend file to append. You can select one of the following data blocks type to
append:

= Group

= Mesh

= Object

= Scene

s Text

= World

= (not complete yet)

Note that this is a complete list, when you append only block types present in the file will appear.
Select the desired type. Now you can select the particular data block to append by selecting its id.

Indirect linking

When you give an append or link command almost all relations between data blocks in Blender get
expanded. For example, when you link (or append) a specific Group, all its objects, the meshes
associated with the objects, the materials and the animations will be linked (or appended) too. That is
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called "indirect linking". When you use dynamic linking such indirect linked data is not stored when
you save a .blend file, when you load the file again blender will look for the indirect linked data
blocks in the library file.

Groups

When you append a Group, blender will also create links in the current Scene to the objects that are
part of the group. The Objects then become visible. However, when you decide to dynamic link a
Group, it won't do that. To use the objects in your blender project you can use the group as a
duplicator "SHIFT+AKEY -> Group menu -> group id to duplicate".

See also

= http://www.blender.org/cms/Library Linking.769.0.html
= http://www.blender.org/cms/Blender Architecture.336.0.html

Creating Blender Libraries

Creating Blender Libraries

You've finally made that perfect object, armature or material: a gamepiece, a robot, a fully rigged
vampire character, or a millimeter-accurate model of the Empire State Building. Besides using this
work in your own artistic project, you have made the courageous decision to share that creation
with the world.

Sharing your creative work is a great way to "give back to the community," even if you don't write
Blender code and you can't translate the Blender documentation to Swabhili.

How to Make a Library

So how do you make a library? In Blender, you don't need to export to a special format. In fact, you
don't need to do anything special beyond saving your regular .blend file. Every .blend is a library file.
Users can Append what they like from your .blend file, and ignore parts which they don't need for
their own project.

This scheme has some benefits and some drawbacks.

The benefit of using .blend files as a library format is that it's super easy to include extra stuff to help
the user see the objects. If the user loads the .blend file directly, it works like the pretty packaging
for foods, including a quick and easy way to get a pretty "serving suggestion" rendering of the
library contents. What you save in your .blend is what the user will see when they load it, including
all your user interface settings, lighting types, and camera positions.

The drawback of using .blend files as a library format is that it's super easy to include unintended
things, such as extra meshes, unused material and texture channels, and other things which the user
will not find helpful. Blender doesn't save things which are no longer referenced anywhere, but it
cannot read your mind if you leave a spare mesh on layer 13 which uses some abandoned
Material.034.

Also, some people are not accustomed to the way that Blender saves all of the user interface settings
along with the .blend file. When they load your mesh, they see your way of working. This can be
instructive, but unless that's your intention, it's best to try to stick to a simple and clean user
interface setup for your library files.

42 de 74 10/09/07 17:20



Blender 3D: Noob to Pro - Miscellaneous Tutorials/Print ve... http://en.wikibooks.org/w/index.php?title=Blender 3D: No...

For best results, you need to apply some discipline to publish a clean and useful library.

Library Usefulness Checklist

After having used several library .blend files from various sources, I propose that anyone making
libraries follow a few suggestions:

keep to a certain object, theme or area of focus for each library file

all the test cameras and lights prefixed with a dash; e.g., -Camera, -HemiLight.001, etc.

any other components not intended for Appending prefixed with a dash; e.g., -ground

all the test cameras and lights on the last one or two layers (lower right layer button)

any composite object intended for Appending organized in a group to hold it together

any groups, objects, materials, textures intended for Appending given meaningful names

document your unit scheme; e.g., 1 blender unit == 1 imperial foot, etc.

any other layer contains test-render-ready objects or scenes

choose rendering and world settings which will not take an hour to make a simple test

render

= make visible upon loading the layers required for a camera, a good lighting angle, and a shared
object

= make visible upon loading one small text file which lists layers and objects

= make visible upon loading any python script, with instructions on how to start it in a big
comment

= make your licensing expectations clear: artistic license, creative commons, etc.

= pack the texture files and other data before saving that final .blend for publishing

® sign your work, stable email address or website url if possible

The dash prefixes for test-rendering cameras, boxes, floors and lights will help the user know at a
glance what to Append and what not to Append from your library.

Here's a quick way to throw out all the stuff you really don't need, including extra meshes, materials
and user interface complexity.

save your current .blend (and make a nice backup file too)

shut down Blender entirely

open up Blender again, which will load the default settings

delete the cube and cameras from the default settings

Append all the useful parts of your library .blend file (including the useful test-rendering items)
select the proper test-rendering camera for users to try out your model quickly (select, then
Ctrl+KEYPADO)

= adjust the views to ensure important things are visible and ready to render

= save the new library .blend, ready to publish

Blender saves the default settings in a file called .b.blend on your disk. If your own preferred
default settings are still too complicated for newcomers to understand, you can move that file away
temporarily to get the "factory" built-in default settings which the Blender team produces as a part of
each new version of the software. Move the file back again when you want to go back to your
individual way of working.

Publishing Your Library

It's helpful to include the .txt file and/or post it separately so that people can read a summary before
loading the blend file. This should include any credits, usage notes, layer explanations, and licensing
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information. For you Unix folks, remember to run it through unix2dos to enforce \r\n CRLF
newlines, readable by people with less flexible tools such as Windows Notepad.

It's also of immense benefit to put up small test-renders of your library objects or materials. They
don't need to be large but they should give an honest view of the work you're sharing before a
potential user takes the time to download library files that will not be useful to them.

So, where do you publish your work of artistic genious?

= Blender 3D Model Repository (http://www.e2-productions.com/bmr)
» http://blenderartists.org/ forums

» http://www.deviantart.com/

= your own website

If you post things on your own website, try not to rely on a free site that will over-run your
bandwidth limits and disappear two months later. Search engine links will sometimes live on for
years, just frustrating those who were hoping to find a millimeter-accurate model of the Empire State
Building.

Beyond Libraries

If you have even more time to spare, consider writing up a tutorial on how you achieved any tricky
results!

Thank You

For every artist who chooses to share their creative works with the community, there are a dozen
artists, or even hundreds, who thank you immensely.

Displacement Mapping Blender 3D: Noob to Pro/Displacement Mapping

Human Body This tutorial should cover the modelling, skinning and animation of human body, plus
facial expressions.

There are some tools to generate human body from parameters like:

s [makehuman (http://www.dedalo-3d.com/index.php) ] free sofware program (gpl). The models
generated are under MIT license. The models generated can be easily imported in blender.

» [facegen (http://www.facegen.com/) ] commercial program. Used for
wikipedia:The Elder Scrolls IV: Oblivion.

links to anatomy sites (warning: nudity):
» [fineart (http://www.fineart.sk/) ]
w [[1] (http://www.3d.sk/) ]
tutorials: Blender 3D: Tutorial Links List#Human
Rendering Informations Only some links to wikipedia articles for now

= wikipedia:Rendering (computer graphics)
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» wikipedia: Specular reflection
» wikipedia:Diffuse reflection

» wikipedia:Flat shading
» wikipedia:Gouraud shading
» wikipedia:Phong shading

» wikipedia: Lambertian diffuse lighting model
= wikipedia:Phong reflection model

Making Landscapes with heightmaps This tutorial will show you how to make advanced terrain such
as mountians using Blender and gimp or any other image editing software. Blender has the ability to
use height maps to create meshes. Height maps are black and white images with white representing
the highest point and black the lowest.

To begin with, open your image editing software. This part applies to Gimp only, if you use another
program you will have to do it another way. Go to

->Filters->Render->clouds->plasma. For this example just use the default settings, it doesn't realy
matter. Click OK. You should now have a nice

colorful image. We don't want that, we want it in black and white. Make sure your Gradient is set to
"FG to BG(RGB)"(this is the default anyway) and that your foreground color is black and the
background color is white. Go to ->Filters->Colors->Map->Gradient Map. This will convert it to
black and white for you. Save your image.

It should look something like this
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Open Blender and delete the default cube. Now add a grid with resolutions 32 and 32 from top view.
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Scale the grid to however big you want your area to be (If this is large you may want to subdivide the
grid some more). Go to the material window (F5) and push the cheese looking button. Add a new

texture

and name it Height. Set the texture type to image and load the image you made earlier.
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Go back to the main material window and look at the texture window.
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This should have Height written in it with a tick next to it. If not click "add new" and select "height".
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Now click the "Map To" tab and deselect "Col".

This will stop the image from changing the color of the grid. Go to the mesh window (F9) and enter
edit mode (TAB). Go to either front or side view so you can

see what you are doing. Click the "noise" button and your grid should start to change shape.
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Continue clicking the button until the terrain has reached the height you want and voila, you have

10/09/07 17:20



Blender 3D: Noob to Pro - Miscellaneous Tutorials/Print ve... http://en.wikibooks.org/w/index.php?title=Blender 3D: No...

just made terrain using heightmaps. You may want

to subsurf the shape to get a smoother effect.
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1.If you want a more jagged landscape then adjust the contrast on the image editing software

2.To texture your landscape you can use your height map by putting whatever you want at the
highest point over the white spots and whatever you want at the lowest points over the black spots.
Then save as a different image.

3.Height maps can also be used to make city terrain. Draw white squares on a black background. If
you do this make sure you make the squares perfectly parallel to the sides of the image. This
prevents jagged edges to buildings. You can also use gray squares to adjust the buildings different
heights.

Modeling a Mug using Spinning and Extrusion Start by deleting the default cube. In front view, Add
a circle. Move the verticies around to form a backwards "L" shape. Select the verticie on the bottom
left and go to Mesh-snap-cursor to selection. Then, in top view, select all the verticies and spin it 360
degrees. Then, select all verticies, hit wkey, and click remove doubles. Then, on one of the sides,
select the middle face. extrude it 0.7, and make an fgon with the three triangles on the side of the
main part. select the two squares on the top of the extrusion and extrude them to 1.82. then
subdivide the inner part of the handle. Select the middle egdes and move them up. extrude the faces
above into the base. position the camera and add a level three light source. Render the model. You
can add color, texture, or anything else.

Add some depth with stereo This tutorial contains some tips for how to work with stereo images. I'm
writing this to help others, to have my notes easily available, and to let others improve my ideas.

Stereo viewing is to see the same thing from two slightly different angles. This is what humans
normally do with our two eyes. There are many ways to view a stereo image. A perfect method is to
use a stereo monitor. But they are quite expensive, and many has very low quality. In the other end of
the price-scale you can use crossviewing. Put the two images next to each other, and look at one
with one eye, and the other with the other eye. Needs a bit of practice though. A popular solution is
red/blue anaglyph glasses, but they give very bad colors.

The stereo camera

I wanted a stereo camera rig that was easy to work with. It should have three cameras (center, left
right), have an easy way to set separation (should be 1/30 of the distance) and I would only need to
work with the center cam (position etc.), to others should just follow.

Create it
Manually

1. Reset the cameras position, rotation and size (you can use ALT+GKEY, ALT+RKEY and
ALT+SKEY). You may want to note these values first, so you can change them back later. I just
make sure there's an IPO-curve for them, for example by making a keyframe (IKEY).

. Create two new cameras. Reset their position, rotation and size too.

3. Name them Camera.Right and Camera.Left or similar. Set LocX to 1 for Camera.Right and -1 for
Camera.Left. (Press NKEY to see data for selected object, in this window you can change name
and values.) (Select a camera by clicking RMB several times on the cameras, until the right one
is selected.)

4. Create a new cube (remember to press TAB to exit edit mode). Reset position, rotation and size.

Name it Distance Cube and set these values: LocZ: -30. SizeX: 0.1. SizeY: 0.1. SizeZ: 30.

. Switch to front view. (NUM1)

6. Select Camera.Left. Then select Camera while holding down SHIFT so both are selected. Press
CTRL+PKEY and press ENTER to register Camera as parent. Then press CTRL+LKEY and

N

o1
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select Camera Data. Repeat with right Camera.Right and Distance Cube.
With a script

I tried making a script that creates the rig, it almost works. Any help finishing it?
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iimport Blender

from Blender import *

# Prepare

iscene = Scene.getCurrent()

icamera = Object.Get("Camera") # TODO validate that it is a camera
oldLocation = camera.loc

oldRotation = camera.rot

oldSize = camera.size

# Create stuff

¢ = Camera.New("ortho")

icameraLeft = Object.New("Camera", "Camera.Left")
«cameraLeft.link(c)

iscene.link(cameralLeft)

¢ = Camera.New("ortho")

,cameraRight = Object.New("Camera", "Camera.Right")
icameraRight.link(c)

iscene.link(cameraRight)

|dEmpty = Object.New("Empty", "Distance")
iscene.link (dEmpty)

# Configure

,camera.loc = (0,0,0)
,camera.rot = (0,0,0)
,camera.size = (1,1,1)

icameraLeft.loc = (-1,0,0)
icameraLeft.rot = (0,0,0)
icameralLeft.size = (1,1,1)

icameraRight.loc (1,0,0)
cameraRight.rot (0,0,0)
cameraRight.size = (1,1,1)

dEmpty.loc = (0,0,-60)
dEmpty.rot (0,0,0)
dEmpty.size = (1,1,1)

iscene.update(1)

# Connect

,camera.makeParent([cameralLeft, cameraRight, dEmpty], 0, 0)
# do that CTRL+LKEY thing
cameraLeft.link(Camera.Get("Camera"))
icameraRight.link(Camera.Get("Camera"))

# Reset original values

icamera.loc = oldLocation
icamera.rot = oldRotation
icamera.size = oldSize

# Finish
Blender.Redraw()
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How to use it

= Never change the cube or the two side-cameras. Only change the center camera. Use that one
for positioning, rotation etc.

= To set the separation: As always, select the center camera. Resize it (with SKEY) so you can see
the end of the cube if needed. Point at the end of the cube with the mouse pointer, and press
SKEY. Move the mouse pointer to the point of the main motive, that is closes to the camera.
The end of the cube may not end exactly there, but that doesn't matter.

» To render (or preview) with one of the side cameras, select it and press CTRL+NUMO.

What needs improvement
The cube is visible

In stead of using a cube, I'd rather use something that doesn't render. It could be an "ampty", but
see below.

The cube is hard to see

It can be hard to see where the cube ends, even in a simple scene. You can select the center camera
AND the cube, then it is clearly visible. But you must remember to only select the camera, before you
insert a keyframe, so your changes to the cube doesn't get saved.

Distance plane is at infinity

The distance plane is where "zero depth is". When viewing a stereo image, the distance plane is
where the medium is. In this rig the distance plane is at infinity, meaning everything is in front ofit.
While stuff popping out in front of the screen is cooler than stuff being "inside" the screen, it's a lot
harder to make it look nice. Specially because with everything in front of the screen, it's easy to get
stuff that is just way to close to the viewer. It can get so hard to see that the 3d-effect is completely
gone.

An easy but wrong solution is to make the side cameras point at the end of the cube, or add a plane
to the rig, and point at that. But then the cameras are no longer parallel, and that creates very ugly
distortions.

The right solution is to (conceptually) render the images too wide, and then crop the excess from the
left side of the left image, and the right side of the right image. The it will look like it points just like in
the wrong solution, but without the distortion.

But this give a lot of problems. First, I'd like to do this a smarter way, in stead of just following the
path describe above. But I don't think that's possible in Blender. (I think povray can actually do this.)
So I need to render the image too wide. But if I increase width in output, it actually renders the same
width of the motive, but decreases height. Then I need to do some weird math to get the right FOV,
and [ don't know half the formulas. Cropping must be done outside Blender, and the rest of "the
production line" is hard to get back into Blender if wanted.

I guess a couple of planes in the rig close to the cameras could simulate the cropping, but that is of
limited value. To make an adjustable distance plane with them seems quite hard to me, it would need
some scripting I guess.

Stereo viewing with the rig
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This is where it gets exciting, now you are actually getting something to look at.

Create a new screen, you could call it Stereo View.

The screen should have one big area from side to side.

Set the area to 3D View

Unlock it (The Locks layers and used Camera to Scene-lock)

Select Camera.Right and press CTRL+NUMO

Split the area in half so there is two parts next to each other

In the right area, select Camera.Left and press CTRL+NUMO

Adjust zoom in both areas so the frame that shows what is rendered is completely visible, but
fill as much as possible. If you can't make them same size, the two areas are not same size.
Use cross-view method to see the 3d-effect. Look at the left area with the right eye and right
area with the left eye. (It's a skill you need to learn and practice.)

10. Press SHIFT+ALT+AKEY to see your scene animated in stereo.

N RLN =

©

Stereo rendering

Creating animated GIFs using Blender and Gimp This tutorial will guide you through how to make a
simple animated Gif Using Blender and Gimp. This is useful for creating Avatars for MSN etc. This
tutorial assumes basic knowledge of blender and Gimp, see the basic animation tutorial [2]
(http://en.wikibooks.org/wiki/Blender 3D: Noob to Pro/Basic Animation) To start off you will need
an animation, this usually should be no longer than 25 frames long.

1. Open Blender. and delete the default cube and add a UV sphere, the default settings for the sphere
work fine.

2. Now set the camera size in the scene buttons (F10) to 50 by 50 (I am creating an avatar for
deviant art where the required size is 50 by 50 pixels, you may change this if you want)

3. set the frames to start at frame 1 and end at frame 20.

4. select the sphere and insert a LOC keyframe at frame 1 and 21, then go to frame 11, move the
sphere and insert another LOC keyframe. this will create a looping animation.

5. Set the image type to png or jpg (it doesn't matter) and render the animation.
Now to combine the images into an animated Gif using Gimp.
6.0pen the first image with gimp.

7. Now click File-> open as Layer or press "Ctrl-Alt-O". Select the next frame and it will be added as a
new layer. Repeat this for all of the images, or select all of the images by pressing "Ctrl-A".

8. If you press Filters->Animation->Playback it should play the animation. It will probably have a low
frame rate making it "clicky". this will be fixed later.

9. Choose file->Save as-> "Name".gif, then choose save as animation. The change the frame rate to
40 ms(25 frames per second) and voila, you are done.

you should end up with something like this .

Note: with my computer when I change to frame rate to 40 ms it sets it to 100 anyway.
To fix this re-open the gif in Gimp and in the layers Dialog box change the (100ms) to
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(40ms) and then save. (NOTE: use this technique to change the frame rate to whatever
you want)

Creating Ogg-Theora movies using Blender Wikimedia Commons requires that movies be uploaded
as Ogg-Theora (OGG) files. As of Blender 2.42a, this is not a builtin feature of Blender. To get OGG
files from your finished animation isn't difficult, though. However, you'll need additional software.

There are basically two ways to generate OGG files: you can use one of the many fine video editors

or you can use special conversion programs. Video editors like LiVES or Cinerella allow you to load
your AVI or your rendered frames, manipulate them, and create the OGG file from it. Please refer to
the editor's documentation on how to achieve this.

A disadvantage of a video editor is they are huge pieces of software, duplicating functionality that
you already used when you created your animation file/s with blender. It's actually not necessary to
install a video editor just for converting your animation to OGG Theora format.

Converting AVIs directly to Ogg Theora

To convert AVI to OGG, you can use the ffmpeg2theora software package
(http://www.v2v.cc/~j/ffmpeg2theora/) which is available in source or binary for all relevant systems.
Usage example:
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Converting saved frame picture files to Ogg Theora

It's actually possible to convert frame pictures that you saved before to OGG format movies. All you
need to do is create a movie format that the abovementioned ffmpeg2theora tool understands, and
then use that. On Linux, this is readily achieved by using the mjpegtools software package
(http://mjpeg.sourceforge.net/) . For example, if your frames were saved as PNG, you could convert
them to a soundless OGG file with:

png2yuv -I p -f 25 /tmp/*.png >my.yuv
ffmpeg2theora --optimize my.yuv

Sound is possible too. Please refer to the mjpegtools documentation.

Soft Body with wind This is the Blender wind and soft body tutorial. This tutorial will try and
help your knowledge of using Soft Body and the Fields and Deflection panels in Blender 3D. (For
best results, I recommend you use Blender version 2.43 or higher). Don’t forget to save your work
at various points throughout the tutorial.

Setting up scene

The plane

Delete the default cube [Delete key, yes] and enter Front view mode [Num. Pad 1]. Add a plane, scale
3 times [S key, 3, Enter] and sub-divide 4 times until you get something like the shape below. If your
computer can handle more, and you want more, sub-divide as many times as you like, but if your PC
is struggling with this, undo once or twice.
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The wind items

TAB out of edit mode (if you haven’t done so already), enter side view [Num Pad 3] and add an empty.
Clear the rotation [ALT + R] and rotate it 90° [R, 90]. Place it about -5 from the centre [G, y, -5] and
make sure its still in the middle of the X axis. Your scene should look like the picture below:
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For the second wind item, add an empty like before and clear its rotation, but DON'T rotate it any
more. Move it along the Y axis by 4 places [G, Y, 4] and -10 by the Z [G, Z, -10]. And now your scene
should look something like this (with all items selected).
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And that’s all your items you’ll need for this. Onto the harder part.

Designating each objects job

The plane

Now, the plane will become a soft body, so enter the Object Panel [F7], click on the Physics Button
(beside the three arrows, see second picture below) and click on the soft body button. You will get a
load of boxes, but we only need to look at the Grav, Goal, and the bottom parts:

Change the values of these as shown above. Change the Aero part to 732 (if you go up to 1000, it
changes the final output by a bit).

Now, click on the Soft Body Collision tab and click on the Self Collision and Deflection buttons. You
don’t need to change any of the numbers here. The buttons window should look something like this:
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Now we will move on to the Empty items which will be the wind.
Creating the wind

The two empty’s we created earlier will be the items that will act like wind, and when you render at
the end, they will be invisible, just like the wind. Anyway, select one of the empty’s and enter the
Physics panel. Click on the box under the Fields and select “Wind”. Change the Strength to 20, click
on Use MaxDist and change MaxDist to 2.5.
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Do the same for the other empty. Your scene should look something like this:
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The movement
This is probably the most complicated part, but shouldn’t take long.

The Empty on the left

In side view [Num pad 3], select the empty on the left and do the following: 1. Press [I key] and then
select LocRotScale from the list it gives you. This inserts a key frame, saying that on this frame, keep
the Location, Rotation and scale the same throughout the rest of the movie, unless it comes across
another key frame, which might tell it to move or stay the same. Now, press the Up Arrow Key until
you get to frame 31 (about 3 times). If you don’t know where the box is that tells you what frame
your on, check the following picture:
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Number 1 shows the current frame number and the name of the selected object while number 2
shows the current frame and allows you to change the frame with the arrows on either side.

Back to the movement

On frame 31, select the empty on the left (the one selected in the picture above) and press [G key].
Now press [Y key] and press “4”, then [Enter key]. Now press [I key] and select LocRotScale again.
Now, if you press and hold the Left Arrow Key, you should see the Empty move back to its starting
place. Now, to check the curve guide (called the "IPO Curve Editor"), right-click on the top panel
(number 1 in picture below), then select "Split Area" and click when the line is a bit out from the side
(number 2 in picture below).
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Now, click on the box (shown below) and select "IPO Curve Editor" from the menu.
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This window just shows where the key frames you entered are, and how much the shape changes,
moves or rotates. Now, go back to frame 1 and press [ALT]+[A], which plays the animation. You
should see the "wind" hit the sheet and the sheet will blow away. Pretty nice, huh? Now, it would be
fine like that (I'll show you how to get rid of the blockyness in the last part), but say you want to hit
the sheet again and send it upwards? We will use the second empty for this.

a1y Emply
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Select the second empty (the one on the bottom). Insert a key frame ([I key], LocRotScale) on frame
1 and frame 50. Go to frame 60, grab the empty and move it up 8 places ([G key], [Z key], 8). Insert a
key frame ([I key], LocRotScale) and then go back to frame 1. You have completed the basics, and
the most of this tutorial. Now, press [ALT]+[A key] and watch your animation.

Finishing touches

Blockiness

Now, to sort out the blockiness, go to the Editing buttons panel [F9] and select the "Set Smooth"
button.
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Now if you preview again ([ALT]+[A]) you should see the plane is smoother, but might be a bit
unrealistic (i.e. not acting like real cloth). Now, that can’t be helped, the only way to get rid of it is to
subdivide the plane several more times, but that will put a LOT of strain on your computer, so I
wouldn’t recommend doing it unless your computer can handle it.

Background

First of all, got to the Scene panel [F10] and over at the Format panel, change SizeX to 400 and SizeY
to 300. Now, to change the background colour when you render, go to the shading panel [F5] and
select the World buttons. Now, in the World panel change HoR to 0, HoG to 0.80 and HoB to 1.0.

- + panels |@ [EI@]0 ﬁ| |3k|@|ﬂ|f'®

% o
U-ﬂ-'." L '&x!.

Feal l“ﬂ@'?ﬁﬂﬁ 1x[Fl

Elerid:

Fapet. HoR oot [IZeRO40 00—
o—— G 0,50 [ T T —
HoE 100 s || 2B 010 1

T T T .
ambaoos — [lEspooo |
AmbEOOr [ Riavge 1,060 ]

All that does is just changes the background colour to a brighter, nicer shade of blue. Now, I'm just
getting a bit lazy, so I'll just explain this part with a picture: (don’t forget to select the plane).
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Change the values and press the buttons shown in the picture. This will change the colour of the
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plane to white.

The only problem now is the light. Press [F12] and you should see what I mean. There's no light
shining on the plane where the camera is, so its just shaded dark. To fix that, select the light and go
to the shading panel [F5]. You now have options for the light. Click on the "Sun" button and press
[ALT]+[R] to clear rotation. Now, in side view [Num pad 3] press [R] and then type -45. Enter top
view [Num pad 7] and press [R] and then -45. This now shines the light in the direction of the plane,
but, if like mine, the light is above the plane in top-view, press [G], [Y] and then -5. The line coming
out of the light source should be roughly pointing at the centre of the plane. Here’s what your
window should look like:
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The pink line is the light. This was taken in camera view [Num pad 0]. Render the frame and you
should see what the final product looks like. Move to any frame you want and press [F12] and it will
show the rendered image for that frame. Now, rendering the entire animation might, in fact, will take
a long time unless you have a completely new PC, are using a big server like DreamWorks (one of the
big PC’s, used for rendering images faster) or have a quicker renderer, I don’t use any external
renderers, and am stuck using a PC that is about 2 years old (in other words, full of junk). It took my
PC less than 5 minutes to render 100 frames, and the last 25 were just blank (as the plane just flew
above the camera). To change the amount of frames to render, and to render the full animation,
here’s what you press:

The box that says End:100 lets you select what frame you finish rendering the animation on (NOTE:
the Sta:1 button lets you select what frame to start rendering the animation). When you press the
ANIM button, it starts rendering the animation. The Box covered in blue, that says Jpeg, lets you
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change the format of the image in the end.

To export the animation as an AVI format, select the AVI button shown below, then press OK. Now,
you need to Animate the sequence again, so press the ANIM button again.
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The finished .AVI will be saved in a folder with the rest of your rendered images. It should be saved
in a folder called tmp, which (on a Microsoft computer) is in My Computer/tmp. The name of the file
will be whatever your start and end frames are, so in this movie, mine is called 0001 0100.avi. You
can now do whatever you want with your movie now, and hopefully you have learned a trick or two
that will be helpful later on in your Blender career.

Final result

Here is an animated .gif of my final result: (imported into Macromedia Flash and exported as an
animated .gif)

--Eb264 /

GNU Free Documentation License

Version 1.2, November 2002
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Copyright (C) 2000,2001,2002 Free Software Foundation, Inc.
51 Franklin St, Fifth Floor, Boston, MA 02110-1301 USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.

0. PREAMBLE

The purpose of this License is to make a manual, textbook, or other functional and useful document
"free" in the sense of freedom: to assure everyone the effective freedom to copy and redistribute it,
with or without modifying it, either commercially or noncommercially. Secondarily, this License
preserves for the author and publisher a way to get credit for their work, while not being considered
responsible for modifications made by others.

This License is a kind of "copyleft", which means that derivative works of the document must
themselves be free in the same sense. It complements the GNU General Public License, which is a
copyleft license designed for free software.

We have designed this License in order to use it for manuals for free software, because free software
needs free documentation: a free program should come with manuals providing the same freedoms
that the software does. But this License is not limited to software manuals; it can be used for any
textual work, regardless of subject matter or whether it is published as a printed book. We
recommend this License principally for works whose purpose is instruction or reference.

1. APPLICABILITY AND DEFINITIONS

This License applies to any manual or other work, in any medium, that contains a notice placed by
the copyright holder saying it can be distributed under the terms of this License. Such a notice
grants a world-wide, royalty-free license, unlimited in duration, to use that work under the
conditions stated herein. The "Document”, below, refers to any such manual or work. Any member
of the public is a licensee, and is addressed as "you". You accept the license if you copy, modify or
distribute the work in a way requiring permission under copyright law.

A "Modified Version" of the Document means any work containing the Document or a portion of'it,
either copied verbatim, or with modifications and/or translated into another language.

A "Secondary Section" is a named appendix or a front-matter section of the Document that deals
exclusively with the relationship of the publishers or authors of the Document to the Document's
overall subject (or to related matters) and contains nothing that could fall directly within that overall
subject. (Thus, if the Document is in part a textbook of mathematics, a Secondary Section may not
explain any mathematics.) The relationship could be a matter of historical connection with the
subject or with related matters, or of legal, commercial, philosophical, ethical or political position
regarding them.

The "Invariant Sections" are certain Secondary Sections whose titles are designated, as being those
of Invariant Sections, in the notice that says that the Document is released under this License. If a
section does not fit the above definition of Secondary then it is not allowed to be designated as
Invariant. The Document may contain zero Invariant Sections. If the Document does not identify any
Invariant Sections then there are none.

The "Cover Texts" are certain short passages of text that are listed, as Front-Cover Texts or
Back-Cover Texts, in the notice that says that the Document is released under this License. A
Front-Cover Text may be at most 5 words, and a Back-Cover Text may be at most 25 words.
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A "Transparent" copy of the Document means a machine-readable copy, represented in a format
whose specification is available to the general public, that is suitable for revising the document
straightforwardly with generic text editors or (for images composed of pixels) generic paint
programs or (for drawings) some widely available drawing editor, and that is suitable for input to
text formatters or for automatic translation to a variety of formats suitable for input to text
formatters. A copy made in an otherwise Transparent file format whose markup, or absence of
markup, has been arranged to thwart or discourage subsequent modification by readers is not
Transparent. An image format is not Transparent if used for any substantial amount of text. A copy
that is not "Transparent" is called "Opaque".

Examples of suitable formats for Transparent copies include plain ASCII without markup, Texinfo
input format, LaTeX input format, SGML or XML using a publicly available DTD, and
standard-conforming simple HTML, PostScript or PDF designed for human modification. Examples
of transparent image formats include PNG, XCF and JPG. Opaque formats include proprietary
formats that can be read and edited only by proprietary word processors, SGML or XML for which
the DTD and/or processing tools are not generally available, and the machine-generated HTML,
PostScript or PDF produced by some word processors for output purposes only.

The "Title Page" means, for a printed book, the title page itself, plus such following pages as are
needed to hold, legibly, the material this License requires to appear in the title page. For works in
formats which do not have any title page as such, "Title Page" means the text near the most
prominent appearance of the work's title, preceding the beginning of the body of the text.

A section "Entitled XYZ" means a named subunit of the Document whose title either is precisely XYZ
or contains XYZ in parentheses following text that translates XYZ in another language. (Here XYZ
stands for a specific section name mentioned below, such as "Acknowledgements", "Dedications”,
"Endorsements"”, or "History".) To "Preserve the Title" of such a section when you modify the
Document means that it remains a section "Entitled XYZ" according to this definition.

The Document may include Warranty Disclaimers next to the notice which states that this License
applies to the Document. These Warranty Disclaimers are considered to be included by reference in
this License, but only as regards disclaiming warranties: any other implication that these Warranty
Disclaimers may have is void and has no effect on the meaning of this License.

2. VERBATIM COPYING

You may copy and distribute the Document in any medium, either commercially or noncommercially,
provided that this License, the copyright notices, and the license notice saying this License applies
to the Document are reproduced in all copies, and that you add no other conditions whatsoever to
those of this License. You may not use technical measures to obstruct or control the reading or
further copying of the copies you make or distribute. However, you may accept compensation in
exchange for copies. If you distribute a large enough number of copies you must also follow the
conditions in section 3.

You may also lend copies, under the same conditions stated above, and you may publicly display
copies.

3. COPYING IN QUANTITY

If you publish printed copies (or copies in media that commonly have printed covers) of the
Document, numbering more than 100, and the Document's license notice requires Cover Texts, you
must enclose the copies in covers that carry, clearly and legibly, all these Cover Texts: Front-Cover
Texts on the front cover, and Back-Cover Texts on the back cover. Both covers must also clearly and
legibly identify you as the publisher of these copies. The front cover must present the full title with
all words of the title equally prominent and visible. You may add other material on the covers in
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addition. Copying with changes limited to the covers, as long as they preserve the title of the
Document and satisfy these conditions, can be treated as verbatim copying in other respects.

If the required texts for either cover are too voluminous to fit legibly, you should put the first ones
listed (as many as fit reasonably) on the actual cover, and continue the rest onto adjacent pages.

If you publish or distribute Opaque copies of the Document numbering more than 100, you must
either include a machine-readable Transparent copy along with each Opaque copy, or state in or with
each Opaque copy a computer-network location from which the general network-using public has
access to download using public-standard network protocols a complete Transparent copy of the
Document, free of added material. If you use the latter option, you must take reasonably prudent
steps, when you begin distribution of Opaque copies in quantity, to ensure that this Transparent
copy will remain thus accessible at the stated location until at least one year after the last time you
distribute an Opaque copy (directly or through your agents or retailers) of that edition to the public.

It is requested, but not required, that you contact the authors of the Document well before
redistributing any large number of copies, to give them a chance to provide you with an updated
version of the Document.

4. MODIFICATIONS

You may copy and distribute a Modified Version of the Document under the conditions of sections 2
and 3 above, provided that you release the Modified Version under precisely this License, with the
Modified Version filling the role of the Document, thus licensing distribution and modification of the
Modified Version to whoever possesses a copy of it. In addition, you must do these things in the
Modified Version:

A. Use in the Title Page (and on the covers, if any) a title distinct from that of the Document, and
from those of previous versions (which should, if there were any, be listed in the History
section of the Document). You may use the same title as a previous version if the original
publisher of that version gives permission.

B. List on the Title Page, as authors, one or more persons or entities responsible for
authorship of the modifications in the Modified Version, together with at least five of the
principal authors of the Document (all of its principal authors, if it has fewer than five), unless
they release you from this requirement.

C. State on the Title page the name of the publisher of the Modified Version, as the publisher.
D. Preserve all the copyright notices of the Document.

E. Add an appropriate copyright notice for your modifications adjacent to the other copyright
notices.

F. Include, immediately after the copyright notices, a license notice giving the public permission
to use the Modified Version under the terms of this License, in the form shown in the
Addendum below.

G. Preserve in that license notice the full lists of Invariant Sections and required Cover Texts
given in the Document's license notice.

H. Include an unaltered copy of this License.

I. Preserve the section Entitled "History", Preserve its Title, and add to it an item stating at least
the title, year, new authors, and publisher of the Modified Version as given on the Title Page. If
there is no section Entitled "History" in the Document, create one stating the title, year, authors,
and publisher of the Document as given on its Title Page, then add an item describing the
Modified Version as stated in the previous sentence.

J. Preserve the network location, if any, given in the Document for public access to a
Transparent copy of the Document, and likewise the network locations given in the Document
for previous versions it was based on. These may be placed in the "History" section. You may
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omit a network location for a work that was published at least four years before the Document
itself, or if the original publisher of the version it refers to gives permission.

K. For any section Entitled "Acknowledgements" or "Dedications", Preserve the Title of the
section, and preserve in the section all the substance and tone of each of the contributor
acknowledgements and/or dedications given therein.

L. Preserve all the Invariant Sections of the Document, unaltered in their text and in their titles.
Section numbers or the equivalent are not considered part of the section titles.

M. Delete any section Entitled "Endorsements". Such a section may not be included in the
Modified Version.

N. Do not retitle any existing section to be Entitled "Endorsements" or to conflict in title with
any Invariant Section.

O. Preserve any Warranty Disclaimers.

If the Modified Version includes new front-matter sections or appendices that qualify as Secondary
Sections and contain no material copied from the Document, you may at your option designate some
or all of these sections as invariant. To do this, add their titles to the list of Invariant Sections in the
Modified Version's license notice. These titles must be distinct from any other section titles.

You may add a section Entitled "Endorsements"”, provided it contains nothing but endorsements of
your Modified Version by various parties--for example, statements of peer review or that the text has
been approved by an organization as the authoritative definition of a standard.

You may add a passage of up to five words as a Front-Cover Text, and a passage of up to 25 words
as a Back-Cover Text, to the end of the list of Cover Texts in the Modified Version. Only one passage
of Front-Cover Text and one of Back-Cover Text may be added by (or through arrangements made
by) any one entity. If the Document already includes a cover text for the same cover, previously
added by you or by arrangement made by the same entity you are acting on behalf of, you may not
add another; but you may replace the old one, on explicit permission from the previous publisher
that added the old one.

The author(s) and publisher(s) of the Document do not by this License give permission to use their
names for publicity for or to assert or imply endorsement of any Modified Version.

5. COMBINING DOCUMENTS

You may combine the Document with other documents released under this License, under the terms
defined in section 4 above for modified versions, provided that you include in the combination all of
the Invariant Sections of all of the original documents, unmodified, and list them all as Invariant
Sections of your combined work in its license notice, and that you preserve all their Warranty
Disclaimers.

The combined work need only contain one copy of this License, and multiple identical Invariant
Sections may be replaced with a single copy. If there are multiple Invariant Sections with the same
name but different contents, make the title of each such section unique by adding at the end of'it, in
parentheses, the name of the original author or publisher of that section if known, or else a unique
number. Make the same adjustment to the section titles in the list of Invariant Sections in the license
notice of the combined work.

In the combination, you must combine any sections Entitled "History" in the various original
documents, forming one section Entitled "History"; likewise combine any sections Entitled
"Acknowledgements"”, and any sections Entitled "Dedications". You must delete all sections Entitled
"Endorsements."

6. COLLECTIONS OF DOCUMENTS
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You may make a collection consisting of the Document and other documents released under this
License, and replace the individual copies of this License in the various documents with a single
copy that is included in the collection, provided that you follow the rules of this License for verbatim
copying of each of the documents in all other respects.

You may extract a single document from such a collection, and distribute it individually under this
License, provided you insert a copy of this License into the extracted document, and follow this
License in all other respects regarding verbatim copying of that document.

7. AGGREGATION WITH INDEPENDENT WORKS

A compilation of the Document or its derivatives with other separate and independent documents or
works, in or on a volume of a storage or distribution medium, is called an "aggregate" if the
copyright resulting from the compilation is not used to limit the legal rights of the compilation's
users beyond what the individual works permit. When the Document is included in an aggregate,
this License does not apply to the other works in the aggregate which are not themselves derivative
works of the Document.

If the Cover Text requirement of section 3 is applicable to these copies of the Document, then if the
Document is less than one half of the entire aggregate, the Document's Cover Texts may be placed
on covers that bracket the Document within the aggregate, or the electronic equivalent of covers if
the Document is in electronic form. Otherwise they must appear on printed covers that bracket the
whole aggregate.

8. TRANSIATION

Translation is considered a kind of modification, so you may distribute translations of the Document
under the terms of section 4. Replacing Invariant Sections with translations requires special
permission from their copyright holders, but you may include translations of some or all Invariant
Sections in addition to the original versions of these Invariant Sections. You may include a
translation of this License, and all the license notices in the Document, and any Warranty
Disclaimers, provided that you also include the original English version of this License and the
original versions of those notices and disclaimers. In case of a disagreement between the translation
and the original version of this License or a notice or disclaimer, the original version will prevail.

If a section in the Document is Entitled "Acknowledgements", "Dedications"”, or "History", the
requirement (section 4) to Preserve its Title (section 1) will typically require changing the actual title.

9. TERMINATION

You may not copy, modify, sublicense, or distribute the Document except as expressly provided for
under this License. Any other attempt to copy, modify, sublicense or distribute the Document is void,
and will automatically terminate your rights under this License. However, parties who have received
copies, or rights, from you under this License will not have their licenses terminated so long as such
parties remain in full compliance.

10. FUTURE REVISIONS OF THIS LICENSE

The Free Software Foundation may publish new, revised versions of the GNU Free Documentation
License from time to time. Such new versions will be similar in spirit to the present version, but may
differ in detail to address new problems or concerns. See http://www.gnu.org/copyleft/.

Each version of the License is given a distinguishing version number. If the Document specifies that
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a particular numbered version of this License "or any later version" applies to it, you have the option
of following the terms and conditions either of that specified version or of any later version that has
been published (not as a draft) by the Free Software Foundation. If the Document does not specify a

version number of this License, you may choose any version ever published (not as a draft) by the
Free Software Foundation.
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= This page was last modified 08:19, 12 April 2007.

= All text is available under the terms of the GNU Free Documentation License (see Copyrights
for details).
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